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  The articles contained in this magazine are released under the Creative Commons Attribution-Share Alike 3.0 Unported license. This means you can adapt, copy, distribute and transmit the articles but only under the following conditions: you must attribute the work to the original author in some way (at least a name, email or URL) and to this magazine by name ('Full Circle Magazine') and the URL www.fullcirclemagazine.org (but not attribute the article(s) in any way that suggests that they endorse you or your use of the work). If you alter, transform, or build upon this work, you must distribute the resulting work under the same, similar or a compatible license. Full Circle magazine is entirely independent of Canonical, the sponsor of the Ubuntu projects, and the views and opinions in the magazine should in no way be assumed to have Canonical endorsement.


  
    Please note: articles in this magazine are provided with absolutely no warranty whatsoever; neither the contributors nor Full Circle Magazine accept any responsibility or liability for loss or damage resulting from readers choosing to apply this content to theirs or others computers and equipment.
  


  Welcome to another issue of Full Circle.


  It's another full house this month. We have Python, LibreOffice, VAX-VMS, Inkscape, Arduino, and an extra HowTo on using LaTeX. In reviews, I'm having a look at GoPanda (a Go client for IGS) and Art is reviewing Linux Lite.


  Charles (Linux Labs) has written an interesting article on testing and troubleshooting old hard drives. If you want to geek out on hard drive fetch times and such-like then this is definitely the article for you. Meanwhile, I try out the Android 'app' Debian noroot. It lets you install a slimmed down Debian on your Android device. And, as the name suggests, it does not require rooting your device.


  Speaking of devices; hopefully for next issue, I'll have a review of the BQ Aquaris M10 Ubuntu Edition tablet. BQ is currently shipping them out to buyers, and some lucky people already have theirs. I'll be trying it as a tablet, and with a Bluetooth keyboard and mouse to see how it performs as a laptop/desktop machine. My idea is to use the tablet (in windowed mode), running GIMP, as a digital sketch pad (of sorts). I'll also try and do a video review of this first ever Ubuntu convergence device. Exciting times!


  And, if you haven't yet given it a listen, try the Full Circle Weekly News. As I write, I've just released FCWN#13. Of course, by the time you read this I'll probably be releasing FCWN#16 or thereabouts. It's purposely kept short (under 10 minutes) and usually features around seven or eight news items. No fluff, nor chit-chat, just the best Ubuntu/Linux/FOSS news items of the week.


  All the best, and keep in touch!


  Ronnie


  ronnie@fullcirclemagazine.org
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  Compiled by Arnfried Walbrecht

  


  Full Circle Weekly News #14 April 23, 2016
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  Download or Listen


  Show Notes


  The show is also available via:


  
    	RSS: http://fullcirclemagazine.org/feed/podcast


    	Stitcher Radio: http://www.stitcher.com/s?fid=85347&refid=stpr


    	TuneIn Radio: http://tunein.com/radio/Full-Circle-Weekly-News-p855064/


    	http://tunein.com/radio/Full-Circle-Weekly-News-p855064/


    	and PlayerFM: https://player.fm/series/the-full-circle-weekly-news

  


  Enjoy! Ronnie

  


  
    EXTRA! EXTRA! READ ALL ABOUT IT!


    Our glorious news reporter (Arnfried) is posting regular news updates to the main Full Circle site.


    Click the NEWS link, in the site menu at the top of the page, and you'll see the news headlines.


    Alternatively, look on the right side of any page on the site, and you'll see the five latest news posts.


    Feel free to discuss the news items. It's maybe something that can spill back from the site into the magazine. Enjoy!

  

  


  "Accel64 for Linux" software supports 64-bit data acquisition processors


  Microstar Laboratories, a provider of Data Acquisition Processor (DAP) systems for PC-based high-performance multichannel measurement applications, has released version 1.00 of the Accel64 for Linux software. This package builds Loadable Kernel Module (LKM) software for the GNU/Linux system, for running on 32-bit or 64-bit hardware architectures, to support the control of DAP data acquisition boards on systems using kernel versions in the 4.xx series. Accel64 for Linux is offered under the BSD license as a free download.


  The Accel64 for Linux software determines what kind of hardware platform is present and selects the native interface mode as the default. However, advanced users who have implemented kernel support for 32-bit software architectures under a 64-bit hardware platform can use either the 64-bit or 32-bit interface, depending on application requirements.


  Source: http://www.electronics-eetimes.com/news/accel64-linux-software-supports-64-bit-data-acquisition-processors


  KDE Plasma 5.6 Released


  KDE Plasma is the desktop environment that powers Kubuntu, Chakra Linux and openSUSE (among others). This week sees the release of Plasma 5.6, which brings several tweaks and improvements.


  KDE is a modern desktop environment, but unlike several desktop environments, it has avoided the trend of "dumbing down" the interface. Although there's much to be said for a simplified environment, power users value the ability to customize and configure their work environments. KDE provides plenty of opportunities to tweak and streamline the experience.


  Of course, the range of choice available in the desktop world means that users are well cared for, whatever their preferences. KDE isn't the only configurable desktop environment, and some users prefer minimal window managers or text-only interfaces.


  Previous versions of Plasma have offered an attractive interface, and the latest release is no exception. This incarnation offers some new polish in the standard themes. Some of these are minor tweaks, such as improving the tooltip animations. Small as they are, they do improve the overall feel.


  Source: http://www.linuxjournal.com/content/kde-plasma-56-released


  Tiny wireless-rich COM runs Linux on Snapdragon 820


  eInfochips has opened pre-orders on a tiny, wireless-rich “Eragon 820” COM and development kit that run Linux or Android on a Snapdragon 820 SoC.


  The eInfochips Eragon 820 is the second computer-on-module we’ve seen based on Qualcomm’s high-end quad-core 64-bit Snapdragon 820 system-on-chip after Intrinsyc’s 82 x 42mm, SODIMM-style Open-Q 820 COM, which similarly comes with a development kit. The Linux- and Android 5.1.1 ready 53 x 25mm module and 110 x 85mm carrier are aimed at “next generation designs in Ultra HD/4K camera and connectivity solutions,” says the company.


  Source: http://linuxgizmos.com/tiny-wireless-rich-com-runs-linux-on-snapdragon-820/


  Rumor: Google's Android camera will get smart with Goggles


  Google might be working on a new feature for Android cameras that allows smartphone photo-snappers to search for information directly from their pictures, SlashGear reports. This tech would essentially combine Google Goggles, a visual-search app that's been around for years, with your Android camera (or Google Camera, if you're really into brand-name apps).


  Google Goggles lets users take pictures of recognizable or famous objects and instantly discover more information about those things. Plus, it can read text in eight languages and translate it. SlashGear reports (citing one anonymous source, it should be noted) that Google's new tech would let users trace an outline around the object they want information on, getting rid of background noise and clutter.


  Source: http://www.engadget.com/2016/03/25/google-goggles-android-cameras-report/


  Universal laptop shell extends phones, mini-PCs, and SBCs


  On Indieogogo, a $119 “dumb” battery-powered “NexDock” laptop offers a 14.1-inch display and a BT keyboard to extend a phone, mini-PC, or Raspberry Pi SBC.


  The NexDock laptop offers a big-screen, mouse and keyboard environment for Android, iOS, and Windows 10 mobile devices, stick computers, and mini-PCs. Silicon Valley startup NexDock also singles out the Raspberry Pi, including the Pi.3, as being compatible with the device, although we imagine just about any HDMI-enabled SBC would work as well. The NexDock is aimed primarily at Windows 10 phones, tablets, and mini-PCs that can exploit Microsoft’s new Continuum feature, which lets you plug in a Windows Phone to a monitor, and use a keyboard and mouse in a scalable, PC-like interface.


  NexDock also hints that it can — or will — be capable of implementing Ubuntu’s somewhat similar convergence feature. Convergence will arrive on the first official Ubuntu tablet, BQ’s Aquaris M10, which today became available for pre-order starting at 250 Euros ($280).


  Source: http://linuxgizmos.com/universal-laptop-shell-extends-phones-mini-pcs-and-sbcs/


  Canonical Announces the Availability of Ubuntu 16.04 LTS Beta for IBM LinuxONE


  Many businesses and enterprises around the world are praising IBM's System z and LinuxONE product line for their unrivaled reliability and security, and Ubuntu Linux is being recognized as one of the most popular free operating systems, the perfect OS for running scale-out workloads in the cloud.


  In approximately three weeks from today, on April 21, 2016, Canonical will unveil the final release of their highly anticipated Ubuntu 16.04 LTS operating system, dubbed Xenial Xerus by the company. And it looks like Ubuntu 16.04 LTS will be the perfect choice for IBM’s LinuxONE and Systems z product lines for cloud deployments.


  Source: http://news.softpedia.com/news/canonical-announces-the-availability-of-ubuntu-16-04-lts-beta-for-ibm-linuxone-502298.shtml


  AT&T is considering making Cyanogen-powered Android phones, says report


  AT&T is thinking about partnering with Cyanogen to build its own version of Android, according to a new report in The Information. The report cites two sources, who claim the carrier had looked to ZTE to build phones running the fork before export sanctions complicated that aspect of the deal. Cyanogen already produces and licenses an alternate version of Android, but this would be by far the largest partnership the company has ever taken on.


  If implemented, the result would be something akin to Amazon's FireOS, a new flavor of Android based on Google's source code but controlled entirely by AT&T. It would also give AT&T sole responsibility for maintaining the OS going forward. New additions to Google's stock Android system might be difficult to incorporate into AT&T's new version, and some might not make it over at all. At the same time, AT&T would be able to integrate phones more deeply into its existing infrastructure. One likely possibility would be an OS-level integration with AT&T's DirectTV service, akin to the Prime video features in Amazon's recent Fire tablets.


  Source: http://www.theverge.com/2016/3/30/11332198/att-cyanogen-android-fork-phone-os


  Ubuntu Make Now Lets You Install Superpowers, Eclipse JEE, IntelliJ EAP & Kotlin


  For those not in the know, Ubuntu Make is an open-source command-line tool designed from the ground up to help developers and programmers install all sorts of third-party applications that aren't available in the Ubuntu repos or don't have a PPA.


  According to Mr. Roche, Ubuntu Make 16.03 is here to add support for installing the Superpowers 2D/3D game maker software, as well as the Eclipse IDE for Java EE developers, IntelliJ IDEA EAP (Early Access Program), and the Kotlin compiler.


  Besides all the goodies mentioned above, Ubuntu Make 16.03 adds some extra tests for the Microsoft Visual Studio Code IDE (Integrated Development Environment), improves the Portuguese translation, and fixes bugs for Android-NDK, Unity3D, Visual Studio Code, Clang, and Intellij-based IDEs.


  Source: http://news.softpedia.com/news/ubuntu-make-now-lets-you-install-superpowers-eclipse-jee-intellij-eap-kotlin-502363.shtml


  Ubuntu’s bash and Linux command line coming to Windows 10


  Microsoft built a Linux subsystem for Windows for Project Astoria, its system for running Android apps on Windows 10 Mobile.


  But in February the company confirmed that Astoria was dead, as it rather undermined the Universal Windows Platform concept. At the time, we speculated that portions of Astoria might live on, as portions of it had mysteriously started showing up in Windows Insider Previews. And today, that has come to pass, with Microsoft saying that the Windows 10 Anniversary Update will include the ability to run the popular bash shell from Unix, along with the rest of a typical Unix command-line environment.


  We're still trying to get the inside story on what Microsoft has done here, but what we've known for several months now is that the company has developed some Windows kernel components (lxcore.sys, lxss.sys, presumably standing for "Linux core" and "Linux subsystem," respectively) that support the major Linux kernel APIs. These components are not GPLed and do not appear to contain Linux code themselves; instead, they implement the Linux kernel API using the native Windows NT API that the Windows kernel provides. Microsoft is calling this the "Windows Subsystem for Linux" (WSL).


  A kernel API is one thing, but to be useful you need user mode applications. For Astoria, this would have been a version of the Android Open Source Project, Google's mostly BSD-licensed code that provides a Java-like runtime and various applications and system services. For WSL, however, Microsoft is turning to Canonical, creators of Ubuntu, for help. Canonical has provided a system image containing the Ubuntu versions of the various command-line tools that are typically found in a Linux distribution.


  Source: http://arstechnica.com/information-technology/2016/03/ubuntus-bash-and-linux-command-line-coming-to-windows-10/


  How Google Plans to Solve Artificial Intelligence


  Padded walls, gloomy lighting, and a ceiling with floral wallpaper. It doesn’t look like a place to make groundbreaking discoveries that change the trajectory of society. But in these simulated, claustrophobic corridors, Demis Hassabis thinks he can lay the foundations for software that’s smart enough to solve humanity’s biggest problems.


  “Our goal's very big,” says Hassabis, whose level-headed manner can mask the audacity of his ideas. He leads a team of roughly 200 computer scientists and neuroscientists at Google’s DeepMind, the London-based group behind the AlphaGo software that defeated the world champion at Go in a five-game series earlier this month, setting a milestone in computing.


  It’s supposed to be just an early checkpoint in an effort Hassabis describes as the Apollo program of artificial intelligence, aimed at “solving intelligence, and then using that to solve everything else.” What passes for smart software today is specialized to a particular task—say, recognizing faces. Hassabis wants to create what he calls general artificial intelligence—something that, like a human, can learn to take on just about any task. He envisions it doing things as diverse as advancing medicine by formulating and testing scientific theories, and bounding around in agile robot bodies.


  Source: https://www.technologyreview.com/s/601139/how-google-plans-to-solve-artificial-intelligence/


  Head of Oracle Linux moves to Microsoft


  While at the Linux Collaboration Summit, I discovered that Wim Coekaerts, formerly Oracle's Senior VP of Linux and Virtualization Engineering, has left Oracle for Microsoft.


  Coekaerts is a very well-known Linux leader. In Oracle he was known as "Mr. Linux." In his Oracle tenure, he brought the company its first Linux products, moved Oracle's programming staff from Windows to Linux desktops and turned Oracle into a Linux distributor with the launch of its Red Hat Enterprise Linux (RHEL) clone, Oracle Linux.


  Microsoft confirmed that it had enticed Coekaerts to leave Oracle for Microsoft. Mike Neil, Microsoft's Corporate Vice President of the Enterprise Cloud, told me, "Wim Coekaerts has joined Microsoft as Corp VP of Open Source in our Enterprise Cloud Group. As we continue to deepen our commitment to open source, Wim will focus on deepening our engagement, contributions and innovation to the open-source community."


  Source: http://www.zdnet.com/article/head-of-oracle-linux-moves-to-microsoft/


  Linux container security is on the evolutionary fast track


  It's been a well-known fact for many years that the standard hypervisor approach to virtualizing a server has a basic flaw in its architectural premise -- it requires each virtual machine to run a separate operating system instance. Hypervisors are designed to enable any operating system to run in a VM, allowing for a greater degree of flexibility. This also means that Windows instances can exist alongside Linux instances in the same machine.


  Once we reach scale levels found in cloud providers, it becomes apparent that there is no real need to mix OSes on any given server, as there are so many instances, segregating them doesn't impact flexibility. With this realization comes the understanding that the hypervisor method wastes a great deal of memory and I/O cycles, since as many as hundreds of copies of the OS could exist on any given server.


  Source: http://searchservervirtualization.techtarget.com/tip/Linux-container-security-is-on-the-evolutionary-fast-track


  Latest Manjaro Linux 15.12 Update Brings Linux Kernel 4.5 and KDE Plasma 5.6.1


  The Manjaro Linux development team announced the general availability of the fourteenth update pack for the Manjaro Linux 15.12 (Capella) operating system.


  With this update, Manjaro Linux 15.12 users will receive the latest KDE Plasma 5.6.1 desktop environment, Calamares 2.2 graphical installer, Octopi 0.8.1 graphical package manager, Qt 5.6 GUI toolkit, Budgie Desktop 10.2.5 desktop environment, numerous Linux kernels updates, a BlueZ bug fix, and improvements to the Menda GTK3 theme.


  As usual, the software repositories of Manjaro Linux 15.12 (Capella) have been synchronized with upstream, which means that it includes all the latest software updates and security patches from the Arch Linux operating system as of March 30, 20:28:59 CEST, 2016.


  Source: http://news.softpedia.com/news/latest-manjaro-linux-15-12-update-brings-linux-kernel-4-5-and-kde-plasma-5-6-1-502502.shtml


  Linux founder Torvalds on the Internet of Things: Security plays second fiddle


  For the first time, Linus Torvalds has spoken at an embedded Linux conference, the Linux Foundation's 2016 Embedded Linux Conference & OpenIoT Summit.


  It's not that embedded Linux hasn't been important before. Your DVRs and Wi-Fi routers almost certainly run Linux. What has changed is that the Internet of Things (IoT) is transforming embedded Linux from being a topic only programmers could love to one everyone will be using soon.


  This development caught Torvalds, Linux's founder, by surprise -- 15 years ago. "I never see the entire chain running Linux. Twenty five years ago I started Linux wanting a workstation. From that to a server wasn't a surprise. There was no single point where I was surprised, but 15 years ago I started seeing these odd, embedded systems. The first one that really caught my eye was a gas pump running Linux."


  Source: http://www.zdnet.com/article/linuxs-founder-linus-torvalds-on-the-internet-of-things/


  Linux Foundation announces Civil Infrastructure Platform


  On the first day of the Embedded Linux Conference, the Linux Foundation announced a new software project called the Civil Infrastructure Platform (CIP).


  CIP is an open source framework that will support the development of software needed to run critical services that create the backbone of any modern society, including electric power, oil and gas, water, health care, communications, and transportation.


  With CIP, the foundation is not only addressing issues related to duplication of work and interoperability that come from using proprietary software, but is also putting open source at the center of this massive market. According to a 2014 PWC report, the global capital project and infrastructure market was worth $4 trillion in 2012 and is expected to climb to nearly $9 trillion by 2025, with 'the majority of the growth' coming from emerging economies.


  Source: http://www.cio.com/article/3051181/open-source-tools/linux-foundation-announces-civil-infrastructure-platform.html


  Full Linux-on-PS4 hits Github


  Ever since fail0verflow first told Chaos Computer Club that Sony PS4 machines could be persuaded to run Linux, a fair amount of work has gone into replicating his demonstration.


  The problem for other PS4 hackers: to avoid take-downs and other things from Sony, fail0verflow published only a Linux-to-PS4 port, leaving the rest of the world to discover the specific exploit used.


  That unleashed a widespread effort, not only to find the best exploit, but to turn it into something stable.


  According to a piece at Wololo.net, Githubber kR105 has laid hands on the holy grail.


  However, this, Wololo writes, is not a demonstration video, it's a “fully operational dlclose exploit” (referring to the Webkit exploit widely believed to lie behind fail0ver's original disclosure).


  Source: http://www.theregister.co.uk/2016/04/04/full_linuxonps4_hits_github/


  How Artificial Intelligence Will Translate Facebook Photos For The Blind


  While it's easy to dwell on the potential threats of artificial intelligence, much more often the field promises to make humans' lives better. A.I. algorithms are meant to help us connect with our friends, find information, and even transport us through the physical world.


  Starting today, Facebook is using artificial intelligence to automatically generate text captions for every photo on Facebook, to provide much-needed accessibility for the blind or visually impaired.


  Because the developers wanted the text generated by the A.I. to be extremely accurate, they trained it intensively on images of just 100 different types of object, so at present it is limited to identifying human, pizza, baseball and the like, but as research progresses, the captions will get increasingly versatile and complex.


  The feature is available now on Facebook's iOS app, and will be rolling out to other platforms soon, as well as to languages other than English.


  Source: http://www.popsci.com/how-artificial-intelligence-will-translate-facebook-photos-for-blind


  The kid is not VSAN: EMC buffs up ScaleIO for high-end types


  EMC has buffed up its ScaleIO virtual SAN software.


  Hopkinton positions ScaleIO as virtual SAN software for higher-end data centres than subsidiary VMware’s VSAN virtual SAN software, and also for customers using Hyper-V server virtualisation, which VSAN does not support. ScaleIO scales out to more nodes than VSAN, we’re told.


  ScaleIO v2.0 supports Ubuntu (Ubuntu OS 14.04 LTS) and CoreOS (hence Docker and containers) and integrates better with OpenStack (Cinder driver), supporting the Liberty release, and contributing to it. VMware Photon support is coming.


  Security additions include Active Directory and LDAP integration, and IPv6 address support. Data-at-rest encryption is coming later this quarter. Data in-flight checksumming has been added to improve resistance against corruption.


  EMC has added expanded support options and read flash cache capabilities plus a 5-node MDM (MetaData Management ) cluster.


  Source: http://www.theregister.co.uk/2016/04/04/emc_soups_up_scaleio_storage_software/


  Google issues biggest Android security update yet


  With fixes for 39 vulnerabilities in Android, the April Nexus Security Bulletin is the largest security update from Google since the company began the monthly update process eight months ago.


  Google fixed 15 vulnerabilities rated as critical, 16 rated as high, and eight as moderate in the latest monthly bulletin, across 26 different components, including DHCPCD, Mediaserver, Bluetooth, Exchange ActiveSync, Wi-Fi, Telephony, media codec, video kernel driver, and Debuggerd. The update also covers the March 18 out-of-band emergency patch, fixing a local privilege escalation flaw in the Android kernel.


  Source: http://www.infoworld.com/article/3051064/security/google-patches-bugs-mediaserver-in-android.html


  Ubuntu Budgie Could Be the New Flavor of Ubuntu Linux, as Part of Ubuntu 16.10


  Last month we told you about a new GNU/Linux distribution called Budgie-Remix, whose ultimate goal is to become an official Ubuntu Linux flavor, possibly under the name of Ubuntu Budgie.


  Today, Budgie-Remix developer David Mohammed informs Softpedia about the progress made with the project, which Canonical founder Mark Shuttleworth said that it would definitely support if there were a community around the packaging, as well as the availability of the second Beta build for the upcoming 16.04 release.


  Since our initial report, it looks like David Mohammed managed to get in contact with the Ubuntu MATE project leader Martin Wimpress, who urged him to target Ubuntu 16.10 for an official status of his soon-to-be-named Ubuntu flavor built on top of the Budgie desktop environment created by the amazing team of developers from Solus.


  Source: http://news.softpedia.com/news/ubuntu-budgie-could-be-the-new-flavor-of-ubuntu-linux-as-part-of-ubuntu-16-10-502573.shtml


  openSUSE Linux Is Being Ported to IBM z Systems and LinuxONE


  Berthold Gunreben of SUSE Linux informed the openSUSE community about the upcoming availability of the openSUSE Linux operating system for the IBM z Systems architecture.


  Also known as IBM System z or s390x, the hardware architecture is used by IBM on all of its mainframe computers, and in recent years, Linux kernel-based operating systems have become very popular for these type of machines, with big names like Fedora, Red Hat Enterprise Linux, and Ubuntu supporting it.


  The SUSE Linux Enterprise Server (SLES) operating system was already supporting the IBM System z architecture for its enterprise customers, but the time has come for the openSUSE Linux OS to support it as well, and today we are happy to inform you that a special port now builds for IBM z Systems in openSUSE Factory.


  Source: http://news.softpedia.com/news/opensuse-linux-is-being-ported-to-ibm-z-systems-and-linuxone-502613.shtml


  Google adds Cloud Test Lab integration to new Android Studio 2.0


  Google has updated its key Android development tool, Android Studio, to version 2.0 and added cloud test integration, a GPU debugger, and faster emulation and resource allocation.


  Mountain view touts the instant run feature as just about the most important new feature in the upgrade, as it analyses Android app code as it runs and determines ways it can be deployed faster, without requiring app re-installation.


  The tool's Android emulator is three times faster too. Connections over command-line tool Android Debug Bridge are 10 times faster than the previous version.


  The integration of cloud testing will be handy, as it means Android Studio can interface directly with Google's fleet of actual real live Android devices for testing. Google's collection lives in its own data centres. The tests will ensure at minimum that apps will not crash on various handsets.


  Source: http://www.theregister.co.uk/2016/04/08/googles_android_20_framework_brings_better_faster_app_development/


  Amazon to Boost Artificial Intelligence with Orbeus Buyout


  According to a report by Bloomberg, e-commerce giant Amazon acquired California-based startup Orbeus last year to enhance its artificial intelligence (AI) capabilities. The financial terms of the deal haven’t been disclosed yet.


  Orbeus has carved its niche in image processing by using AI. Orbeus’ photo-recognition technology is based on ReKognition API. This technology allows other software developers to add facial or object recognition to their own products.


  In the case of Amazon, the company is investing heavily in AI to automate warehouse operations, improve its delivery systems and add new products to its Amazon Web Services cloud offering.


  Source: http://www.zacks.com/stock/news/212645/amazon-to-boost-artificial-intelligence-with-orbeus-buyout


  Android Marshmallow update for Samsung Galaxy Note 4 begins international rollout


  Months after early pre-release versions of the software allegedly appeared on some Galaxy Note 4 units, the official Android Marshmallow rollout has started.


  Several of SamMobile’s readers informed the site that the update is rolling out for the Exynos-powered N910C variant of the 2014 flagship. Likewise, Dutch Samsung blog, GalaxyClub corroborates those reports. The update apparently weighs in at a hefty 1.3GB and brings the software up to version 6.0.1. What’s more, it comes with the April Android security patch which was only released by Google a few days ago.


  As previous rumors suggested, the Marshmallow update brings with it some features from the Galaxy Note 5. Most notably, Note 4 users will be able to take notes on the lock screen while it’s in standby. Other updates, as usual, include the ‘Doze’ standby power-saving feature, and more granular app permission controls. There’s no mention of whether or not Samsung included the ability to ‘adopt’ MicroSD cards as internal storage, but we’re presuming — given its stance with the S7 — it won’t be featured in any of its phones.


  Source: http://9to5google.com/2016/04/08/android-marshmallow-update-for-galaxy-note-4-begins-international-rollout/


  Open-Source AMDGPU Linux Driver Gets Major Update with More than 50 Improvements


  AMDGPU (also known as xf86-video-amdgpu) is an open-source and very performant graphics driver dedicated to AMD Radeon GPUs (Graphics Processing Units), integrated into the mainline Linux kernel since version 4.2. Until now, AMDGPU received a single minor update, xf86-video-amdgpu 1.0.1, but today's release adds multiple changes.


  Release highlights of AMDGPU 1.1.0 include support for the upcoming Polaris 10 and 11 family of AMD GPUs, makes the OpenGL and VDPAU (Video Decode and Presentation API for Unix) interoperation to work with DRI3 enabled, add the "TearFree" option to prevent tearing with reflection and rotation under X.Org Server 1.16 or later.


  Source: http://news.softpedia.com/news/open-source-amdgpu-linux-driver-gets-major-update-with-more-than-50-improvements-502700.shtml


  DDoS Attacks with BillGates Linux Malware Intensify


  Over the past six months, security researchers from Akamai's SIRT team have observed a shift in the cyber-criminal underground to using botnets created via the BillGates malware to launch massive 100+ Gbps DDoS attacks.


  The BillGates malware is a relatively old malware family aimed at Linux machines running in server environments. Its primary purpose is to infect servers, link them together in a botnet controlled via a central C&C server, which instructs bots to launch DDoS attacks at their targets.


  The malware has been around for some years, and due to its (irony-filled) name is probably one of the most well-known Linux-targeting malware families.


  While not as powerful as the XOR botnet, which was capable of launching 150+ Gbps attacks, BillGates attacks can go over 100 Gbps when needed.


  Source: http://news.softpedia.com/news/ddos-attacks-with-billgates-linux-malware-intensify-502697.shtml


  Ubuntu plugs code exec, DoS Linux kernel holes


  Ubuntu has patched four Linux kernel vulnerabilities that allowed for arbitrary code execution and denial of service attacks.


  The flaws (CVE-2015-8812, CVE-2016-2085, CVE-2016-2550, CVE-2016-2847) are fixed in Ubuntu 14.04 LTS:


  Researcher Venkatesh Pottem found a use-after-free vulnerability in the Linux kernel CXGB3 driver which local hackers could use to trigger a crash or execute arbitrary code.


  Xiaofei Rex Guo reported a second timing side channel vulnerability in the Linux Extended Verification Module which impacted system integrity.


  A third hole found by bug basher David Herrmann could exhaust resources and cause denial of service.


  The final vulnerability unattributed to a researcher also triggered denial of service thanks to the Linux kernel not enforcing limits on the amount of data allocated to buffer pipes.


  The problems impact Ubuntu 14.04 LTS, the current long-term support version of Ubuntu which will be smothered in love and patches until 2019.


  Source: http://www.theregister.co.uk/2016/04/07/ubuntu_kernel_patch/


  On-Board Wi-Fi, Bluetooth Support In Ubuntu MATE 16.04 for Raspberry Pi 3


  With the new move, users of the Ubuntu MATE for Raspberry Pi OS platform will now receive access to the forthcoming Ubuntu MATE 16.04 LTS (Xenial Xerus) branch. The update is expected to bring users a host of new features including a new Welcome screen built specifically with Raspberry Pi-centric features in mind, as well as many updated components.


  The most exciting addition to Ubuntu MATE 16.04 for Raspberry would be the new onboard Wi-Fi and Bluetooth support made possible by the BlueZ 5.37 component.


  This new system is based on the Linux Kernel 4.1.19 LTS, and includes Raspberry firmware 1.20160315-1, wiringpi 2.32, nuscratch 20160115, sonic-pi 2.9.0, and omx-player 0.3.7~git20160206~cb91001.


  Source: http://www.mobipicker.com/board-wi-fi-bluetooth-support-ubuntu-mate-16-04-raspberry-pi-3/


  Researchers help shut down spam botnet that enslaved 4,000 Linux machines


  A botnet that enslaved about 4,000 Linux computers and caused them to blast the Internet with spam for more than a year has finally been shut down.


  Known as Mumblehard, the botnet was the product of highly skilled developers. It used a custom "packer" to conceal the Perl-based source code that made it run, a backdoor that gave attackers persistent access, and a mail daemon that was able to send large volumes of spam. Command servers that coordinated the compromised machines' operations could also send messages to Spamhaus requesting the delisting of any Mumblehard-based IP addresses that sneaked into the real-time composite blocking list, or CBL, maintained by the anti-spam service.


  Source: http://arstechnica.com/security/2016/04/researchers-help-shut-down-spam-botnet-that-enslaved-4000-linux-machines/


  Sony officially updates Xperia Z2, Z3, and Z3 Compact to Android Marshmallow


  In a somewhat unprecedented move, Sony Mobile decided to allow users of select flagship Xperia handhelds to opt into a Marshmallow Beta program for those interested in the bleeding-edge of Android OS updates. Given the nature of an early pre-release build, there were some bugs to squash along the way. Today however, Xperia Blog is reporting that Sony has officially started rolling out the final release build of Marshmallow 6.0.1 to the Xperia Z2, Z3, and Z3 Compact handsets.


  Only specific variants of the devices are currently set to receive the OTA: the Xperia Z2 with model number D6503, the Xperia Z3 with model number D6603 and the Xperia Z3 Compact with model number D5803. Coincidentally, these are the variants that were eligible for the beta program, suggesting that Sony itself may have put them on a fast-track release schedule.


  Source: http://www.androidauthority.com/sony-officially-updates-xperia-z2-z3-z3-compact-android-marshmallow-685305/


  WhatsApp 2.16.20 Download Available for Android Devices


  WhatsApp is one of the most used mobile messaging applications out there, being used by millions of people every day. The application is now totally free, as Facebook, the owner of WhatsApp, has decided to remove the annual fee of 0.99 dollars.


  The new WhatsApp 2.16.20 APK (installation) file has 27MB in size and it can now be downloaded and installed on your Android device. It is good to know that the latest WhatsApp BETA version can now be installed directly from the Google Play Store, but you will firstly need to join the WhatsApp BETA Testing program.


  Source: http://neurogadget.net/2016/04/09/whatsapp-2-16-20-download-available-android-devices/27729


  Torvalds prepared to spend next 25 years helping Linux conquer the desktop


  The phrase "year of the Linux desktop" has been around for well over a decade, but it has become more of a meme rather than a statement of fact. Without a doubt, Linux has seen much success on mobile devices, including smartphones and tablets, as well as servers, network appliances, and the emerging "internet of things" device category. However, despite Microsoft stumbling with Windows Vista and Windows 8.x, Linux failed to capitalize on these moments of weakness. In a recent interview with CIO, Torvalds cited that the "desktop hasn't really taken over the world like Linux has in many other areas". However, he remained positive about the prospects of Linux on the desktop.


  If we look through an alternate lens, Linux may end up seeing more success as we head towards a future where hybrid and converged solutions are increasingly offered. Canonical's failed ambition to crowdsource an Ubuntu-powered smartphone offering a full desktop PC experience may have been ahead of its time but serves as an indication of things to come.


  Source: http://www.neowin.net/news/torvalds-prepared-to-spend-next-25-years-helping-linux-conquer-the-desktopGorgeous


  Manjaro Linux Enlightenment E20 16.04 Edition Officially Released


  Based on the latest stable branch of the Arch Linux-based Manjaro Linux OS, Manjaro Linux Enlightenment 16.04 Community Edition is now built on top of the Enlightenment 20 desktop environment/window manager.


  It is powered by the latest long-term supported Linux 4.4.6 kernel, adds the SDDM login manager, uses the Thus graphical installer, and enables non-free drivers and multilib support for the 64-bit ISO images.


  Additionally, the Abiword word processor, Pamac package manager, Terminology terminal emulator, QISOUSB Live USB creator, LXTask task manager, and tools like Galculator, XSensors, and Chroot are also installed by default.


  Source: http://news.softpedia.com/news/gorgeous-manjaro-linux-enlightenment-e20-16-04-edition-officially-released-502769.shtml


  ubuntuBSD 15.10 Beta 5 Out Now to Fix a Hang Issue for the Thunar File Manager


  ubuntuBSD developer Jon Boden has announced that the fifth Beta build of the upcoming ubuntuBSD 15.10 operating system is ready for public testing.


  ubuntuBSD 15.10 Beta 5 comes hot on the heels of the fourth Beta release announced a few days ago, on April 7, 2016, bringing bug fixes for some hang issues reported by users in the Thunar file manager. Check the Launchpad bug report for more details on that.


  Early adopters can help Mr. Boden discover bugs and issues in the ubuntuBSD operating system. Please report bugs on the Launchpad website.


  When testing ubuntuBSD, please try to keep in mind that it is still a pre-release version of the operating system, not suitable for deployment in production environments. Also, note that the ISO image will not run in live mode, for now.


  Source: http://news.softpedia.com/news/ubuntubsd-15-10-beta-5-out-now-to-fix-a-hang-issue-for-the-thunar-file-manager-502771.shtml


  Android N is going to be way more disability-friendly


  As Google notes, more than 20 percent of the population will experience a physical disability sometime in their lives. Because of this, it makes sense that the company would want their operating system to cater to this massive slice of the population as much as it can. Although Android has had a variety of accessibility options in the past, Android N is looking to increase these drastically.


  The main feature that Android N is sporting is the Vision Settings, which lets its users adjust font size, all around magnification, and TalkBack. The idea is to make these accessibility features more, well, accessible. In that spirit, Google is putting them right on the welcome screen, which lets users independently configure their devices to better accommodate for the way they navigate their world.


  Source: http://www.androidauthority.com/android-n-accessibility-685835/


  Interpreting, enforcing and changing the GNU GPL, as applied to combining Linux and ZFS


  The Free Software Foundation published a statement called "Interpreting, enforcing and changing the GNU GPL, as applied to combining Linux and ZFS," by our founder and president, Richard M. Stallman.


  This statement explains why the current license of ZFS prevents it from being combined with Linux. To reach that conclusion, our statement covers all the necessary background for understanding license incompatibilities and violations in general.


  In January of 2005, we added to our license list an explanation that the Common Development and Distribution License, version 1.0 (CDDL), though a free license, is incompatible with all versions of the GNU General Public License (GNU GPL). While the CDDL is not commonly used, it is the license that Sun Microsystems (and now Oracle) chose for distributing the file system ZFS. ZFS was originally written for Solaris, but recent projects aim to make it work as a module with other operating system kernels, including Linux, which is licensed under the terms of the GNU GPL version 2.


  Normally, incompatibility questions like this are raised by people trying to write proprietary modules for copyleft free programs. They want to benefit from the work done by free software developers without providing others the same freedom, and they treat users unethically. That is not the case here, because ZFS is free software. The ideal solution would be for Oracle, who has become a large and tremendously influential distributor of GPL-covered code, to show their leadership by giving explicit permission allowing their ZFS work to be used under the GPL.


  Source: https://www.fsf.org/licensing/zfs-and-linux


  Chakra GNU/Linux Gets KDE Plasma 5.6.2, Frameworks 5.21.0, and LibreOffice 5.1.2


  Chakra GNU/Linux maintainer Neofytos Kolokotronis announced the availability of the latest KDE technologies in the main repositories of the Arch Linux-based operating system.


  Just like Arch Linux, Chakra GNU/Linux is a rolling release distribution, which means that users install it once and get free updates for the rest of their lives, or at least until they decide to move to another Linux kernel-based operating system.


  Chakra GNU/Linux focused on the latest KDE software, so its maintainers are always updating the KDE technologies included in the distribution to recent releases, quite soon after they're made available from upstream.


  Additionally, users can also update their LibreOffice installations to the latest 5.1.2 maintenance release, and it looks like the Steam for Linux installer was updated to version 1.0.0.52.


  All these goodies are now live in Chakra GNU/Linux, and you can get them right now by applying all the available updates through your favorite package manager.


  Source: http://linux.softpedia.com/blog/chakra-gnu-linux-gets-kde-plasma-5-6-2-frameworks-5-21-0-and-libreoffice-5-1-2-502779.shtml


  Canonical Eases Ubuntu App Development with New Build Dependency Rules


  Ubuntu release manager Steve Langasek informs the community about some changes happening to build-dependency handling in Ubuntu 16.04 LTS (Xenial Xerus) and upcoming versions of the widely used operating system.


  According to Mr. Langasek, the Ubuntu development team admits that the process of separating Ubuntu packages between the "main" and "universe" software repositories caused the Ubuntu development to be dragged down because the "main" repo also covered build-dependencies in addition to dependencies.


  Starting with the upcoming Ubuntu 16.04 LTS (Xenial Xerus) operating system, the Ubuntu development team will offer a more lightweight "main" repository containing only the packages that matter most to end users. Work on this has already started by moving many Ubuntu packages from "main" to "universe."


  Source: http://news.softpedia.com/news/canonical-eases-ubuntu-app-development-with-new-build-dependency-rules-502783.shtml


  Canonical Is Delighted to Collaborate with Nexenta on Optimizing ZFS for Ubuntu


  Canonical announced the extension of their partnership with Nexenta to provide their customers with a joint software-defined storage solution.


  The joint solution formed by Nexenta, the world's most popular OpenSDS (Open Source-driven Software-Defined Storage) developer, in collaboration with Canonical, the company behind one of the world's most popular Linux kernel-based operating systems, is here to pair the Ubuntu OpenStack platform with the award-winning SDS solution from Nexenta.


  During the OpenStack Summit 2015 event, both Canonical and Nexenta have announced an upcoming alliance that will benefit enterprise OpenStack customers from a new software-defined storage solution, by integrating NexentaEdge, the high performance object and block storage service from Nexenta, with Canonical's Juju open source service modeling tool, which Ubuntu users can use to manage, deploy, and scale apps on OpenStack clouds.


  Source: http://news.softpedia.com/news/canonical-is-delighted-to-collaborate-with-nexenta-on-optimizing-zfs-for-ubuntu-502806.shtml


  Facebook’s future: Artificial intelligence, drones and virtual reality


  Facebook Inc. plans to eventually make an augmented reality device so small it might one day resemble a pair of glasses. The company unveiled this Google Glass-like aspiration along with drones, solar-powered planes and bots as part of a 10-year road map for the company on Tuesday.


  During the keynote at Facebook’s F8 developer conference, Zuckerberg said Oculus, the virtual-reality company Facebook bought in 2014 for $2 billion, will eventually be able to shrink down the size of its hardware so that it can be viewed through traditional-looking eyeglasses.


  Zuckerberg said artificial intelligence will eventually be able to understand what it intakes, such as content from video or photos, and speak to users using natural language. The company announced the beta launch of Bot Engine on Tuesday, a personal assistant service on Messenger that will help users with tasks such as finding out the weather or making dinner reservations.


  Source: http://www.marketwatch.com/story/facebooks-future-artificial-intelligence-drones-and-virtual-reality-2016-04-12


  SQL Server's Road to Linux


  Microsoft first publicly proclaimed its love for Linux less than 18 months ago and ever since, the company has taken substantive steps to show this wasn't just a crush. Granted, the love of Linux expressed by CEO Satya Nadella followed a long courtship, which included the company's full-blown support in Microsoft Azure. Microsoft's cloud also included support for other open source software and languages such as Java, Node.js, PHP, Python and Ruby, among others. Despite touting incremental advances including the milestone last year that 20 percent of applications in Azure ran on Linux servers or virtual machines, its progress went largely unnoticed.


  Nevertheless, Microsoft kept pushing, taking once-unthinkable steps such as opening the .NET Core framework and its Visual Studio Code editor, support for Linux containers via Docker in Windows Server, forging close ties with Red Hat, and having a prominent presence at events like the Chef developer conference, just to name a few.


  Source: https://redmondmag.com/articles/2016/04/01/road-to-linux.aspx


  Canonical Releases LXD 2.0 Next-Generation Container Hypervisor for Ubuntu 16.04


  LXD 2.0 has been in development for the last three months, during which it received four Beta releases, and no less than nine RC (Release Candidate) builds, and it comes as a worthy upgrade to LXD 0.27 and previous releases. It is also the first long-term support version, making it a production-ready container hypervisor.


  Prominent new features of LXD 2.0 include support for block I/O limits, support for network I/O limits, support of optimized container transfers in the Btrfs backend, the ability to use regular expressions as filters for "lxc list" and "lxc image list", revamped REST API, deprecation of Go 1.5 and previous versions, and a new "--fast" mode for "lxc list".


  Additionally, "lxc info" now lists the container architecture, Cgroup namespace is now supported, it is possible to run Docker inside an LXD container, the upload progress is reported when importing images, recursive bind-mounts are now supported, and the lxd-images script was removed completely.


  Source: http://news.softpedia.com/news/canonical-releases-lxd-2-0-next-generation-container-hypervisor-for-ubuntu-16-04-502856.shtml


  Genymobile Launches Genymotion Cloud, An Android Emulator Platform For Advanced Collaboration, Automated Testing, And More


  The name Genymobile is well-known throughout the Android development community for building a very fast and efficient emulator before it was cool. Today, Genymobile announced an ambitious new direction for the technology: Genymotion Cloud. Tagged as the first cloud-based Android emulator, Genymotion Cloud is targeted at business and enterprise customers with some big new collaboration and automated testing features.


  An Android emulator remains at the heart of Genymotion Cloud, but as the name implies, the emulators are running remotely. The idea here is that it's possible to set up an instance for use in a wide variety of ways. It can be a tool for developers to collaborate remotely, for designers and management to evaluate progress and offer feedback, and even sales and marketing teams which may use it for demos to potential clients.


  Instances of the emulator are accessible both through the IDE plugins and a web interface, making them easy to use for demonstrations within a company or for sales and support calls. Genymobile is focusing on turning the cloud infrastructure into a tool that can be used across different roles for different reasons.


  Source: http://www.androidpolice.com/2016/04/11/genymobile-launches-genymotion-cloud-an-android-emulator-platform-for-advanced-collaboration-automated-testing-and-more/


  Linux-fight! Dev's plan to bundle kernel patches sparks debate


  Linux developer Sasha Levin has kicked off a project in which he proposes gathering up kernel security fixes under a single tree.


  The rationale behind the “Linux-stable security tree project”, he explains, is that sysadmins in large, complex deployments find following kernel upgrades is daunting.


  “Quite a few users of the stable trees pointed out that on complex deployments, where validation is non-trivial, there is little incentive to follow the stable tree after the product has been deployed to production,” the announcement says.


  Sysadmins are therefore caught between a rock and a hard place: try to keep up with every kernel fix so as to catch security fixes (difficult), or opt out of fixes because it's all too hard (dangerous).


  Levin reckons some projects “preferred to delay important kernel updates, and a few even stopped updating the tree altogether, exposing them to critical vulnerabilities”.


  In response to a question from another developer, Levin says the Linux-stable security tree project will be to catch “anything exploitable by a local unprivileged user (or better),” whether or not it's attracted the attention of Mitre and been issued a CVE.


  Levin notes that he hopes to be able to maintain a security tree for all -stable branch versions that are still maintained – that is, he won't only be following the very latest kernel revision.


  Source: http://www.theregister.co.uk/2016/04/13/linux_dev_hopes_to_simplify_security_patching/


  Linux AIO Passes the 200,000 Downloads Mark, Celebrates with a Zorin 11 Live ISO


  The Linux AIO project passed the 200,000 downloads mark and, in celebration of the event, released a Live ISO image for the Zorin OS 11 distro.


  The announcement comes as great news for the Linux community, and we would like to congratulate the Linux AIO team for providing us with updated and unique Live ISO images that contain the most popular flavors of many GNU/Linux distributions.


  The second part of today's announcement from the Linux AIO team is about the release of the Linux AIO Zorin 11 Live ISO image, which contains the Zorin OS 11 Core 64-bit, Zorin OS 11 Core 32-bit, and Zorin OS 11 Lite 32-bit flavors.


  Users can download the Linux AIO Zorin 11 Live ISO image, write it to a USB flash drive, and use it wherever they go to showcase and, eventually, install the Core or Lite edition of the Zorin OS 11 operating system of PCs or laptops.


  The Linux AIO Zorin 11 Live image also contains two useful utilities that let you check the memory of a computer for errors, as well as to verify the hardware compatibility of the respective system before attempting to install Zorin OS 11 on it.


  Source: http://news.softpedia.com/news/linux-aio-passes-the-200-000-downloads-mark-celebrates-with-a-zorin-11-live-iso-502870.shtml


  The ODROID XU4 is a palm-sized PC with an octo-core processor, but can it be your desktop?


  Mini-PCs like the Raspberry Pi are loved tinkerers and retro gamers — could they be fast enough to take on the everyday things you’d do on a desktop PC? Here’s a look at one single board computer, the ODROID XU4, and how it stacks up as a desktop computer, complete with x86 emulation through Exagear Desktop, so it can run programs like Skype and even Microsoft Office.


  The ODROID XU4 is a single board computer built by Hardkernel. At the heart of the XU4 is a Samsung Exynos 5422 2GHz, octo-core processor, with 2GB of RAM. The board also packs gigabit Ethernet, two USB 3.0 ports, a single USB 2.0 port, HDMI output, a CPU cooling fan, and general-purpose input/output (GPIO) ports for your own tinkering and experimenting. The ARM-based computer can run a number of operating systems including Debian, Ubuntu, and Android.


  Source: https://www.yahoo.com/tech/affordable-arm-based-computers-evolved-131557017.html


  Debian-Based Parsix GNU/Linux 8.0 (Mumble) Has Reached End of Life, Upgrade Now


  The developers behind the Debian-based Parsix GNU/Linux distribution have officially ended support for the Parsix GNU/Linux 8.0 (Mumble) release, starting today, April 16, 2016.


  The end-of-life (EOL) announcement for the Parsix GNU/Linux 8.0 (Mumble) operating system, which was based on the Debian GNU/Linux 8.0 "Jessie" series, went live a month ago, in mid-March. We then advised our readers to consider upgrading to the current stable, supported release of the distribution.


  And now that Parsix GNU/Linux 8.0 (Mumble) has been marked with an EOL (End-of-Life) status, it means that it will no longer receive software updates, important bug fixes, nor critical security updates. In other words, you have no choice but to upgrade to Parsix GNU/Linux 8.5 (Atticus) as soon as possible.


  Source: http://news.softpedia.com/news/debian-based-parsix-gnu-linux-8-0-mumble-has-reached-end-of-life-upgrade-now-503037.shtml


  Manjaro Linux Drops Support for Kernel 4.3, Users Urged to Move to Linux 4.4 LTS


  The Manjaro development team has announced the general availability of a new update pack for the Manjaro Linux 15.12 (Capella) operating system, urging users to update as soon as possible.


  As usual with any new Manjaro 15.12 Update Pack, users get the latest software versions, and this time is no different. The Manjaro update released on April 15, 2016, brings the latest KDE Plasma 5.6.2 and Cinnamon 2.8.8 desktop environments, ALSA 1.1.1 sound server, Python2, and the open-source AMDGPU 1.1.0 (xf86-video-amdgpu) graphics driver for AMD Radeon GPUs.


  The update pack also introduces new kernel versions for the Manjaro Linux 15.12 (Capella) operating system, among which we can mention Linux 3.10.101 LTS, Linux 3.12.57 LTS, Linux 3.13.11.38, Linux 3.14.65 LTS, Linux 3.16.7.26, Linux 3.18.30 LTS, Linux 3.19.8.18, Linux 4.1.21 LTS, Linux 4.2.8.7, Linux 4.4.6 LTS, Linux 4.5, and Linux 4.6 Release Candidate 2.


  Also new in the latest update pack for Manjaro Linux 15.12 (Capella) is a preview version of the soon-to-be-redesigned Pamac graphical package manager. This should allow user to double-click on a package's name to view extra info, see a dependency's details by clicking on a dependency in the dependencies view, as well as browse the packages during transactions.


  Source: http://news.softpedia.com/news/manjaro-linux-drops-support-for-kernel-4-3-users-urged-to-move-to-linux-4-4-lts-503043.shtml


  openSUSE Tumbleweed Users Get KDE Plasma 5.6.2, Frameworks 5.21 and Mesa 11.2.0


  openSUSE Tumbleweed users have received many snapshots during the last two weeks, since the beginning of the April, so it's time to bring you, guys, up to speed with what's new in the rolling GNU/Linux distribution.


  The fact of the matter is that a lot of things are new in openSUSE Tumbleweed, all the time. For example, the distro was the first to get the Linux 4.5 kernel on March 18, 2016, just a few days after its initial launch on March 14, and it also received the latest GNOME 3.20 desktop environment after only one week after it had been announced.


  During the past two weeks, the openSUSE Tumbleweed repositories have been flooded with all the latest GNU/Linux software and technologies, among which we can mention the KDE Plasma 5.6.2 desktop environment, Mesa 11.2.0 3D Graphics Library, as well as KDE Framework 5.21.0 collection of add-on libraries for Qt5. Also, it looks like the XChat IRC client has been replaced with HexChat.


  Source: http://news.softpedia.com/news/opensuse-tumbleweed-users-get-kde-plasma-5-6-2-linux-kernel-4-5-1-mesa-11-2-0-503056.shtml


  Ubuntu 16.04 LTS Brings Docker 1.10 with Fan Networking to Every Architecture


  Canonical's Dustin Kirkland informed the Ubuntu community about the availability of the Docker 1.10 Linux container engine for every supported architecture in Ubuntu 16.04 LTS (Xenial Xerus).


  Ubuntu 16.04 LTS launches next week, on April 21, 2016, and Canonical has started revealing many of its upcoming features. Some of those, which may interest LXD users, are support for the Docker 1.10 Linux container engine on every Ubuntu architecture and the ability to run Docker inside LXD.


  Therefore, after upgrading their systems to Ubuntu 16.04 LTS on April 21 and after that, users will find Ubuntu Docker binaries and images for the ARMHf, ARM64 (AArch64), i686 (32-bit), amd64 (64-bit), PPC64el (PowerPC 64-bit Little Endian), and s390x (IBM System z) hardware architectures.


  Dustin Kirkland, who is part of Canonical's Ubuntu Product and Strategy team led by Mark Shuttleworth, has also had the great pleasure of announcing the general availability of Ubuntu Fan Networking, allowing users to connect all of their Docker containers that are spread across the network.


  Source: http://news.softpedia.com/news/ubuntu-16-04-lts-brings-docker-1-10-with-fan-networking-to-every-architecture-503061.shtml


  Meet MeLE PCG02U, a Fanless Intel Bay Trail PC Stick Running Ubuntu 14.04 LTS


  Shenzhen Mele Digital Technology Ltd., a Chinese manufacturer of mini PCs, 4K UHD Android TV box sets, OTT solutions, Android OTT+DVB TV boxes, HD media players, Internet hybrid TV boxes, and accessories, is planning on releasing a Linux-powered version of its popular PC stick products.


  The MeLE PC Stick PCG02U will come with the same internals as the current Windows 10-powered version, the PCG02, such as an x86 Intel Atom Bay Trail Z3735F Quad-Core processor running at 1.33 GHz and offering Intel HD graphics, 32GB eMMC 5.0 internal flash storage, and 802.11 b/g/n Wi-Fi operating at 2.4 Ghz with an extrenal antenna.


  It will also feature Bluetooth 4.0 and 10/100M Ethernet connectivity, HDMI 1.4 video and audio output, a single USB 2.0 port with data connection, a single microUSB port that can only be used for power connection, a microSD card reader, a Kensington lock, and 1 GB DDR3 RAM.


  MeLE PC Stick PCG02U will be available later this year for the measly price of $59 (~€50). According to the video presentation attched at the end of the article, thanks to ARMdevices.net, MeLE also plans on offering a version with 2 GB DDR3 RAM, for which users will have to pay only $10 more.


  Source: http://news.softpedia.com/news/meet-mele-pcg02u-a-fanless-intel-bay-trail-pc-stick-running-ubuntu-14-04-lts-503064.shtml


  MIT Reveals AI Platform Which Detects 85 Percent of Cyberattacks


  Today's cybersecurity professionals face daunting tasks: protecting enterprise networks from threats as best they can, damage limitation when data breaches occur, cyber forensics and documenting the evolution and spread of digital attacks and malware across the world.


  It can be a challenge in an industry where many companies find themselves short-staffed and unable to find enough trained staff to maintain their ground against state-sponsored hackers which are tasked with stealing financial data, sensitive corporate intellectual property or spying upon unsuspecting victims.


  Protecting infrastructure and people often is down to two sectors: man or machine. In today's current climate, there is a vast array of digital tools available to security professionals to streamline their tasks, but the bulk of the burden falls on human shoulders.


  Could a new artificial intelligence platform change this? MIT researchers believe so.


  Source: http://www.zdnet.com/article/mit-reveals-ai-platform-which-detects-85-percent-of-cyberattacks/


  Richard Stallman Talks GNU, Linux, Terrorism and French Politics


  What is Richard Stallman, the father of free software (if not open source) like in person? And what is he thinking now about Linux, terrorism and French politics? I gained some insight recently when the founder of the GNU operating system spoke near Paris.


  I glimpsed Stallman for the first time as he boarded the bus I was riding from Paris to the suburb of Choisy-le-Roi, where he gave a talk at a library last weekend to promote "free digital society." Out of breath and sporting khaki pants, a green polo and a worn Monoprix bag, he was immediately unmistakable.


  Stallman says in his description of his "lifestyle" that he hates wasting time. He indeed wasted no time after boarding the bus before pulling out a laptop. He hacked for the duration of the hour-long ride to Choisy-le-Roi.


  Source: http://thevarguy.com/open-source-application-software-companies/richard-stallman-talks-gnu-linux-terrorism-and-french-pol


  Ubuntu Budgie 16.04 Linux Is Just Around the Corner, Release Candidate Out Now


  David Mohammed has informed about the immediate availability for download and testing of the Release Candidate (RC) build of the soon-to-become Ubuntu Budgie flavor.


  Of course, this won't be possible until at least the Ubuntu 16.10 development cycle starts, which will happen later this spring. But for now, the developer prepares to unveil the final version of Budgie Remix 16.04, as part of next week's Ubuntu 16.04 LTS (Xenial Xerus) operating system, and you can now test-drive the Release Candidate.


  Since Beta 2, the developers managed to update the slideshow of the Ubiquity graphical installer, revise some of the options of the installer, center the clock applet on the panel, remove budgie-xfdashboard by default, add the Plank dock by default, as well as make GNOME Calendar the default calendar app.


  Source: http://news.softpedia.com/news/ubuntu-budgie-16-04-linux-os-is-just-around-the-corner-release-candidate-is-out-503084.shtml


  Microsoft and Google Want to Let AI Loose on Our Most Private Data


  The recent emergence of a powerful machine-learning technique known as deep learning has made computing giants such as Google, Facebook, and Microsoft even hungrier for data. It’s what lets software learn to do things like recognize images or understand language.


  Yet many problems where deep learning could be most valuable involve data that is hard to come by or is held by organizations that are unwilling to share it. And as Apple CEO Tim Cook puts it, some consumers are already concerned about companies “gobbling up” their personal information.


  Shmatikov and researchers at Microsoft and Google are all working on ways to get around that privacy problem. By providing ways to use and train the artificial neural networks used in deep learning without needing to gobble up everything, they hope to be able to train smarter software, and convince the guardians of sensitive data to make use of such systems.


  Source: https://www.technologyreview.com/s/601294/microsoft-and-google-want-to-let-artificial-intelligence-loose-on-our-most-private-data/


  PWOBot: Python malware family can eat Windows, Linux and OS X


  PALO ALTO NETWORKS has come at us with a report of what it claims is a cross-platform malware family written in Python that can attack Windows and be ported to Linux and OS X.


  The security firm explained in a blog post that the threat spends most of its time bothering Windows, most notably in Poland, but is making geographical and operating system switches.


  "We have discovered a malware family named ‘PWOBot' that is fairly unique because it is written entirely in Python and compiled via PyInstaller to generate a Microsoft Windows executable," said Palo Alto threat intelligence analyst Josh Grunzweig.


  There are at least 12 variants of PWOBot, according to the post, which have been floating around for a few years, but the new cross-platform nature should get people sitting up.


  PWOBot will first uninstall any previous versions of the malware, then install new versions with malevolent intentions.


  Source: http://www.theinquirer.net/inquirer/news/2455133/pwobot-python-malware-family-can-eat-windows-linux-and-os-x


  Ubuntu-Based Escuelas Linux 4.4 Released for Schools as a Windows XP Replacement


  The biggest piece of news concerning the Escuelas Linux 4.4 release is that the OS has been rebased on the recently announced Bodhi Linux 3.2 distribution, which in turn is based on the Ubuntu 14.04 LTS (Trusty Tahr) operating system.


  However, it looks like there are so many internal changes that the Escuelas Linux development has team declared the 4.4 release as the most important in the history of the project, and it is highly recommended as a replacement for old Windows XP PCs.


  But you can also install Escuelas Linux on computers where Windows 8 or Windows 10 is running much more easily, thanks to the UEFI improvements added in the 4.4 release. Additionally, the installation manual has been completely redesigned.


  Numerous of the pre-installed packages have been updated to their latest versions at the moment of the release of Escuelas Linux 4.4, and among the most important ones, we can mention LibreOffice 5.1.2, Mozilla Firefox 45.0, and Geogebra 5.0.226.


  Source: http://news.softpedia.com/news/ubuntu-based-escuelas-linux-4-4-released-for-schools-as-a-windows-xp-replacement-503136.shtml


  Ubuntu SDK IDE and DevKit Officially Released for Ubuntu 16.04, Built on Qt 5.6


  Built on Qt 5.6.0 and based on Qt Creator 3.5.1, the new Ubuntu SDK IDE and Devkit packages come with a great set of new features. Among them, we can mention the ability to detect ARM64 (AArch64) devices, support for migrating templates to UITK (UI Toolkit) 1.3, as well as the upgrade of the Ubuntu Desktop Kit to the APIs of the OTA-11 update for Ubuntu Touch mobile OS.


  Moreover, it is now possible to enable the distribution of the Ubuntu SDK IDE and DevKit packages in the "snap" and "click" formats, and there is also the ability to adjust the HTML5 template to mirror the QML sample application. The UI Toolkit (UITK) component gallery has been improved, and it should work as expected now (available from Tools -> Ubuntu -> Showcase Gallery).


  In the coming days, the Ubuntu SDK team will prepare a small point release promising to add a new welcome screen, which provides users with direct access to the UI Toolkit showcase gallery, as well as a fully functional desktop kit targeted at click packaged (ARMHf) pocket desktop IDE (Integrated Development Environment).,


  Source: http://news.softpedia.com/news/ubuntu-sdk-ide-and-devkit-officially-released-for-ubuntu-16-04-built-on-qt-5-6-503188.shtml

  


  For more NEWS goto http://fullcirclemagazine.org/news/

  


  Command & Conquer: Python to Create JSON Database


  Lucas Westermann


  A few months ago, I was asked to create a JSON database for integration into an ubuntu phone app. Up until then, I’ve only ever used JSON files, but not created them from real-world data/files. I then set about using Python to list all files that should appear in the app, and creating the relevant JSON data. Since then, I’ve begun a data management and analysis course - where we work with similar JSON files. So for this month’s C&C, I’m going to walk you through how I created a new Python script to create a JSON database of my previous C&C articles. This way, I’ll be able to easily check when I wrote an article, and what the topic was.


  The Script


  I’ve posted my copy of the script on Pastebin: http://pastebin.com/eLASuY1T


  But… I Don’t Have Your Articles!


  This script isn’t intended to be used as-is. You can easily adjust it to generate lists/databases of files based off filenames. This is what I’ll be focusing on in the article.


  What Will I Need?


  The scripts are tested in Python 3.5. Older versions of 3 should work without issues - if you’re using Python2, you’ll need to adjust the code according to the error messages you’re given.


  I’ve linked my version of the script with Drive - the CLI tool for managing Google Drive. If you’re not interested in using it, you can safely ignore/delete the lines 3-6, 26-40, and 107. Otherwise you’ll need: Drive (see Further Reading), and to have imported subprocess.call, and contextlib.contextmanager.


  Otherwise the rest of the imports are necessary, and standard libraries.


  What Do I Need To Change?


  These changes are mandatory - and need to be adjusted for your system. Optional changes can be found in the next section.


  You’ll want to edit line 9 - this is the target file (txtFile) for the intermediary list of all articles.


  You’ll also need to edit line 13 - and adjust the list to contain the paths you want to include in your database. It is expected to be a list, so even if you’re looking at a single path, make sure it’s wrapped in square brackets.


  If you don’t separate out the filename information with “ - “, then you’ll need to change line 70.


  What Can I Change?


  Line 10 indicates the file path to the JSON file. By default it’s fcm-database.json in the current folder.


  Line 16 contains a dictionary that stores the date of issue 100 (August, 2015). This is important for the calculations in dateFind. The reason it’s not integrated into the function, is so it can be more easily changed.


  Line 17 contains the empty dictionary which is used per entry. It could be integrated into a method, but I left it in to illustrate how it works (and to ensure that there’s a -1 element to delete).


  How Does It Work?


  The first 25 lines are mainly variables that need to be set up for later functions. Most should be self-explanatory, and so I will skip them. Lines 26-40 are explained in the section “Drive Functions”.


  Function: dateFind


  This function was created to calculate the month and year that corresponds to the article. This is important for me, as some topics can be outdated - so if a topic was covered in 2012, it may be time for a refresh. It does so by knowing one date (#100 was for August, 2015), and the difference between the currently processed issue, and issue 100. So issue 98 would be a difference of 2, and 107 would be -7. The difference (times 365/12 - roughly one month) is then subtracted from the date of the startPoint (2015-08), and results in a new year and month. The days shift, but since FCM is a monthly release, it’s unimportant (and even deleted entirely with the strftime function).


  One could also just multiply 32 by the difference - though having that many extra days for some months may cause more problems. It’s by no means perfect - as it’s cumulative, there may be problems with February issues (for example).


  Function: createArticleList


  This function uses os.listdir, and some regexp/searches to ensure that only my articles are accounted for. Since my files are in the format FCM100 - C&C - Title, I simply make sure the filename starts with FCM[0-9]+ (one or more numbers after the FCM). I also make sure it doesn’t contain .desktop (this is important for drive - as every file has a .desktop companion). Once the lists have been added into output, the list isn’t flat (has multiple sublists). That’s what line 54 fixes.


  Line 55 removes any .odt extension listed (as Google Drive files have no extension, and .odt was what I originally used). Lastly, I use the same sort of replace function to shorten any Command & Conquer into C&C - not strictly necessary, but ensures things are uniform.


  Line 57 ensures there are no duplicates - as a Python set can contain only unique values. This essentially drops any duplicate filenames.


  The list is then printed into a temporary file (which is practical for debugging, or if you just want to see quickly how many files there are). The file is then closed, and the function returns True.


  Function: update_database


  This is the crux of the file. It essentially opens the article-list.txt file, and reads each line of it. For each non-empty line, it then does the following steps:


  
    	Split the line on the “ - “ separator (so you get a list like this: [‘FCM100’, ‘C&C’, ‘Title’])


    	Removes the FCM part - to get just the issue number.


    	Creates an empty key/value pair in the entry dict.


    	Fills the information into the entry dict (if the title is empty - as some of my files were poorly named in the past, it just inserts a string “Unknown”). It also removes any newline characters.


    	dateFind is used to calculate the estimated date for that issue.


    	Database.update is used to insert (or update) the information for the current issue.

  


  Once the for loop is completed, the file is then closed, the -1 entry of the database (original entryTemplate) is deleted, and the database is returned.


  Function: write_database


  This is a quick function that uses json.dumps to simply write the dict to a JSON file. It also indents it nicely.


  Function: write_csv_database


  This function uses csv.writer to create a valid CSV file. Line 95 dumps the keys of an entry (specifically, entry 100) into a list. The list is then used to create the CSV header, and also to make sure the order of the values are the same as the headers - so it matches up.


  Function: main


  This is just a function where I call the rest of the helper functions (and debugged issues). You can just as easily paste this into the if __name__ == “__main__” area, but the recommendation is to use a main function, to allow easier importing.


  Drive Functions


  Function: cd


  This just recreates the cd function from Bash, but also reverts to the original directory - so that the drive pull command can be executed in the correct directory, without messing up later writes to JSON or CSV files. Originally found on StackOverflow (see Further Reading).


  Function: update_drive


  This calls the cd command inside a with (to ensure the directory reverts), and calls drive pull.


  Why Do Some Functions Return True?


  This is mainly to indicate that the function completed correctly. It’s also a useful step if you want to support error handling.


  What Do I Do With The Database?


  There are a few things you can do. Using something like OpenRefine, you can clean up your database (such as find out which files are lacking titles). Or else you can export it to a CSV and import it into Google Sheets or similar.


  Lastly, you can open it in something like Python’s Pandas and analyse it however you’d like.


  Can I Search?


  You can either open the JSON file and search by hand, open it in some form of data analysis tool, or write a new function to search the nested dictionary structure in Python itself.


  I hope this article proves interesting to at least a few readers. Or, barring that, gives you some inspiration for new projects of your own. If you have any comments, suggestions or extensions, feel free to email me at lswest34+fcm@gmail.com.


  Further Reading


  
    	https://github.com/odeke-em/drive - Drive CLI tool.


    	http://stackoverflow.com/questions/431684/how-do-i-cd-in-python/24176022#24176022 - Stack Overflow cd command in Linux.

  


  
    Lucas has learned all he knows from repeatedly breaking his system, then having no other option but to discover how to fix it. You can email Lucas at: lswest34@gmail.com.
  


  How To - Python in the REAL World - Part 65


  By G.D. Walters


  Welcome back. This month will be a hodgepodge of information. The main reason is that there are some important advances in tech and you will need time to get some parts for the next few articles.


  In the near future, we will be adding the Arduino into our toolbox. I suggest starting off with the UNO or a UNO clone which can be purchased for less than $30 US (22). We will also need some sensors to really get going. While these are optional and you can just read the article, building these projects are more than half the fun. So, with that said, here is a list of parts…


  
    	One Wire Digital Temperature Sensor - DS18B20


    	DHT11 Basic Temperature/Humidity Sensor


    	16x2 LCD Display


    	4.7K and 10K ¼ Watt resistors (3 or 4 of each)


    	Large Breadboard (60+ x 10 with power rails)


    	10K Potentiometer (2 or 3)


    	Male to Female jumpers (Pi to Breadboard) about 8”


    	Male to Male jumpers (Arduino to Breadboard) about 8”


    	Male to Male jumpers (Breadboard to Breadboard) small to medium


    	Toy/Hobby motor 6 VDC


    	L293D or SN754410 Motor Control Chip


    	4 AA Battery Holder and Batteries.

  


  This will pretty much get you going for the next few months. Of course, you could get more and explore on your own. Most everything on the list is less than $10 US. If you shop the internet diligently, you can get very good prices on everything really inexpensively. We’ll leave this for now, but for next time, you will need the DS18B20 temperature sensor and a 4.7K resistor as well as a breadboard and jumpers if you don’t already have one.


  Recently, there has been a great stir on the Internet about the Amazon Echo / Alexa device software being ported to run on the Raspberry Pi. The biggest reason for the excitement is that currently the Echo / Alexa is available only in the US and many people in the UK and other countries have been waiting, not so patiently, for it. This gives them a chance to enjoy the technology.


  There are at least two projects currently working on getting Echo on the Pi. The first uses Java. You can find the code and instructions at https://github.com/amzn/alexa-avs-raspberry-pi. I have done this project on both a Pi Version 1B and the new Pi 3B. It worked well on both. Many people have problems getting this to work, but I did it in about 4 hours (with small breaks and interruptions), and it worked the first time. The best advice I can give you is take your time, plan on a long weekend, and follow the instructions to the letter. The only problem that I had was that npm and nvm needed to be installed, and, at that time, these installation instructions were not included. I believe this issue has been corrected.


  The second project uses Python and is located at https://github.com/lennysh/AlexaPi. To be honest, I tried this, but could not get it to run. I will tell you that I did not spend nearly as much time on this project as I did on the Java version, due to many doctor visits this past week. I intend to spend more time on it to try to get it working.


  If you decide to try either projects, PLEASE use a blank SD card and not one that has something you want to keep. Load the Raspbian or NOOBS OS from scratch. That way, if something goes wrong, you can just reload the OS and start fresh.


  There are some things you need to know before you attempt to do this project. All of the information below pertains to the java version, but some can be considered to apply to both projects…


  
    	You need to have a USB microphone. Headphone based microphones have issues. I’m using a Logitech webcam with built in microphone and it works well.


    	You will also need a set of speakers or headphones attached to the audio out jack. Many people have had lots of issues with bluetooth audio devices.


    	You must push a button to get the Echo / Alexa to listen for your command. It doesn’t currently listen for the “wake” word. (more below).


    	Some of the features that the actual Echo / Alexa have don’t currently work.


    	Things like location, weather, traffic, work correctly only in the USA. In any other country, you will get information for Seattle, Washington, USA.


    	The only supported language currently is English. According to what I was able to find out from my research is that, once the device is being sold in a given country, they will add support for that country's “official” language. I understand that in the UK, the official language is English, and that in the USA, there is no “official” language and that Spanish is a largely spoken language, but is not supported on the device as yet. There are many flame threads on the web – if you wish to voice your ire at the fact that your language of choice is not supported or that the Echo / Alexa is not available there. All I can suggest is that you should be patient. The device was a sleeper for a while and just recently took off well. Amazon, I’m sure, is working on support for other countries right now.


    	When you start the app, you have to run two processes. The second one will create a GUI box which has a long URL string that you must copy and paste into a web browser. Once that gets to Amazon properly, then you must click the [OK] button on the screen. You will be presented with a screen that has a [Start Listening] button and some multimedia buttons. To “wake” Alexa up, you click the ‘start listening’ button and, after you hear the “ding”, speak your question or command. When finished, you can click that button again to have it stop listening and process your command, or you can let it timeout (about 5 seconds) then it will start processing. Many people are working on headless operation (no monitor) and a physical button connected to a GPIO pin, and some are actually working on the “wake” word option. You can find more information in the issues section.


    	You should (read MUST) use a decent quality SD card. My suggestion is to get nothing less than a Class 10 card that is no smaller than 16 Gig.


    	As soon as you boot into the new operating system for the first time, run a ‘sudo raspi-config’. Be sure to enlarge the file system to take in the entire card. Be sure to turn SSH on. You will need to reboot here. Next you should then do a ‘sudo apt-get update’ and then a ‘sudo apt-get dist-upgrade’ so you are at the latest software revisions.


    	There are some steps that require you to enter certain data. Make notes of what you entered, either by a screen shot, into your smartphone, or (HORRORS!!!!!!) on paper. It will make things easier.


    	If you have any problems, check the issues section. More than likely someone has already had the same problem and there might be a fix.


    	Print the web page with the instructions and work off the print. This way, you can check off those steps you have already completed. Especially helpful if you get interrupted.


    	You can find more information, and change certain settings, at alexa.amazon.com. I understand that some people who are not in the USA have problems with this site.

  


  I think that’s enough for this month, but next month, we will turn our RPi into a thermometer. The neat thing about using the DS18B20 sensor is that you have more of them on a single line. This way, you could use one in the living room, one outside, etc. We’ll use these sensors later on with the Arduino and be able to use the arduino as a remote device so we don’t have to try to run a long cable and change the resistance to a point that it won’t work.


  Until next month, enjoy checking out the Alexa project, and, if you try it / them, hope you have success.


  
    Greg Walters is owner of RainyDay Solutions, LLC, a consulting company in Aurora, Colorado, and has been programming since 1 972. He enjoys cooking, hiking, music, and spending time with his family. His website is www.thedesignatedgeek.net.
  


  LibreOffice part 59, Document Fields


  by Elmer Perry


  Often, when creating a document, you find the need to insert information about the document into the document. You can use LibreOffice fields to get information like page number, total pages, title, author, word count, etc. With minimal setup, you can insert the information into your document, and the fields will update as their values change.


  Common Fields


  A group of fields are available directly through the menus, and I call them the common fields, since some developer decided they were the most used. They are located under Insert > Fields. The fields are Page Number, Page Count, Date, Time, Title, Author, and Subject. You will see later where the Title, Author, and Subject fields are set.


  The Page Number is related to the current page on the current document, while the Page Count is the total number of pages in the document. These fields are handy because they can change from the time you enter them. You might insert a page before the current page. Without the fields, you would have to go through every page after the insert and renumber the pages. Using the fields, the page numbers will adjust automatically. The same is true of the page count. As you edit, you might increase or decrease the total number of pages.


  The Date and Time fields allow you to insert the current date and time. We saw a good example of using the date and time fields in the last issue (Full Circle 107) in my article on Auto Text, but they are also useful in templates and master documents.


  To insert the common fields, just select them from the menu Insert > Fields.


  Metadata


  Before we dive further into document fields, we will look at the places where much of the information used by the fields is stored. The two main sources for the information are ‘user data’ and the document properties. Each provides reusable information.


  User Data


  [image: office01]


  User Data is information about the author (or user) of the document. You can access the User Data at Tools > Options > LibreOffice > User Data. If you have never filled out this information, it is blank. Text boxes are provided for first, last name and initials, as well as full address, title, phones, fax, and email. If you are in a company environment, there is also a box for the company name. Check the box "Use data for document properties" to have LibreOffice to automatically apply information like the name as author to the document properties of new documents. Any changes you make to the User Data takes effect only after you restart LibreOffice.


  Document Data


  There’s a wealth of fields related to the document itself. Some of them are listed in the common fields under Insert > Fields. Some of the information, like word count, page numbers, page count, changes as the document is edited and revised. Other options like the title and subject are added by the writer or editor of the document. The document fields are located in the properties of the document, File > Properties.
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  The General tab shows us a wealth of information that we can't change from this dialog. You can see the file name and its location, as well as its size, creation, and last modified dates. At the bottom of the tab, you find a check box labeled "Apply user data." When checked, it saves the user's full name with the file. The name used is the one in the User Data mentioned above. The revision number is nothing more than a count of the number of times the document has been saved. If, like me, you save often, this number ticks up quickly. The Reset Properties button will reset all the dates, modifications, author, and revisions to the current state. The current user becomes the author, the created and last modified fields change to the current date and time, and revisions is set to 1.
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  The Description tab is where you provide the basic information about the document. If you are not in the habit of using this, I recommend giving it a try. You can use this data to maintain consistency in your document. You have text boxes for the title, subject, keywords, and comments. These inputs are where the fields look for this information, so this tab is key to using fields like title and subject.
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  The Custom Properties tab allows you to create your own properties for the document. For example, when creating a document, you need to create a header entry on each page with your last name and a shortened title. To create this custom field, click on the Add button. You get entry boxes for Name, Type, and Value. You can click on the arrow for the Name and see some predefined suggestions for field names or fill in your own. You won't find any that meet our needs, so you type in "Short Title" for the name. There are six different types, Text, DateTime, Date, Duration, Number, and Yes or No. In this case, you are just adding a text property, so you select Text. In the Value text box, enter your last name and short title. For example, "Perry/LibreOffice 59." Click OK when you are finished adding custom properties.


  Document Fields


  While LibreOffice gives you quick access through the menu to Title, Author, and Subject, dozens of other document fields are available. They are located in the fields dialog. You access them under Insert > Fields > More Fields.


  [image: office04]


  On the Document tab, you have general information. While some of the common fields are here like Title, Date, and Time, you can do more with them here than you can by just selecting them from the menu. When you select the Author, you discover you can insert the name or just the writer's initials. Selecting Date or Time gives you a wealth of formatting options. You have options for Chapter, File name, and Page. Sender gives you a list of all the data from the User Data in the LibreOffice options. Statistics allows you to insert tallies on different elements of the document: pages, paragraphs, words, characters, tables, images, and objects. Templates lets you insert information about the template used to create the document.
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  The DocInformation tab contains even more fields about the current document. You can insert the Comments, as well as the Keywords, from the document's properties. There are fields for when the document was created, last modified, and last printed – with options to insert the author, time, and date of the creation, modification, or printing. Subject and Title show up here as well. The Revision number, as I already mentioned, is just the number of times the document has been saved. The "Total editing time" is just that, the total amount of time you have spent with this document open. You can select several formats for this field depending on how you want it to display. Might come in handy if you need to report how long you spent creating and editing a document. You will also find your custom created properties here under Custom.


  Once you select any of these fields and the related options, you can click on the Insert button to insert them into your document. If any changes occur, the fields will automatically update. If you need to use one of the fields from the dialog often, you can create an Auto Text – the way you did in part 68 for the Journal Entries (Full Circle 107). Also, the keyboard shortcut for the fields dialog is CTRL-F2.


  Finally, I'm sure you have noticed that fields get highlighted in gray. The highlighting does not show when you print the document. You can control whether or not the shading shows at Tools > Options > LibreOffice > Appearance. You can change the color of the Field Shadings option, or uncheck it to prevent it from showing. To quickly turn the shading on and off, select View > Field Shadings from the menu, or press CTRL-F8.


  Using LibreOffice fields, you can insert information about your document directly into the document, and have those fields update as they change. Besides the common fields, you will find statistical fields, fields about the author, fields about the document, and you can even create your own fields. To create quicker access to a field formatted a certain way, you can create an Auto Text entry with a shortcut to access the entry.


  
    Elmer Perry 's history of working, and programming, computers involves an Apple ][E, adding some Amiga, a generous helping of DOS and Windows, a dash of Unix, and blend well with Linux and Ubuntu. He blogs at http://eeperry.wordpress.com
  


  Migration from VAX/VMS to Linux - part 4 - mailboxes


  By Theo van Oosten


  In the early days of computers, a company called Digital Equipment Corporation (DEC) created its 32-bit VAX computer using openVMS as its operating system. Because a VAX/VMS computer is so reliable, there are today - after more than 25 years - still a large number of them in use. But, in the end, even these reliable computers will have to be replaced. As described in part 1, you could migrate from VAX/VMS to Linux, as the way Linux works is largely compatible with VAX/VMS. If you use Pascal as your programming language, you will find that Lazarus/Free Pascal is a good replacement. But there are technical functions used in VMS with no apparent replacement in Linux. In this article, I will, among others, describe how to replace mailboxes, and deal with file version numbers and packed arrays of char (strings).


  Mailboxes


  For IPC (interprocess communication), VMS offers mailboxes. In Linux, there is a perfect replacement, only the way you create and use them is very different:


  - To create a mailbox in VMS, you call $CREMBX (handle, logical_name, permanent). The identifier of the opened link to the (new) device named MBAxxxx (xxxx is a number between 0 and 9999) is assigned to “handle”. By using the boolean argument “permanent”, VMS is told to create a mailbox that will still exist after all processes linked to that mailbox are gone (otherwise, it will be deleted and the content is lost). The given logical name (for an explanation of logicals, see part 3) is used to see if the mailbox already exists. VMS will look for it in the table LNM$PERMANENT_MAILBOXES or LNM$TEMPORARY_MAILBOXES, depending on the value of 'permanent'. If found, the logical is 'translated', and the mailbox it points to is referenced; if not, a new mailbox is created and the logical - pointing to the newly created mailbox - is created in the above mentioned table.


  In Linux you have to get a key first. In the examples from the documentation, they use the function ftok (file-to-key) for that. You pass the file specification of an existing file, plus a small number between 0 and 255, to this function, and it converts this to a large number, the key. If you hand over the same file and number, you will get the same key. This might suggest that this file will contain the content of the mailbox, but that's not true. The file is only used to get a unique key. The meaning of this file can be compared to the logical used by VMS.


  Now you can create or link to a mailbox using this key as the identifier to get a handle. So you can use two methods: Either create a dummy file for every mailbox you want to use and always use 0 as the small number, or use, e.g., the folder at the base of the current version of your project (see part 3) to get separate mailboxes for every version and assign a constant (smaller than 256) to every mailbox to get the unique key. Whichever method you use, the created mailbox will be permanent. In Linux there are no temporary mailboxes. So be aware of that when starting a new session; you might get old messages left in the mailboxes from a previous run.


  - Now you are ready to send and receive messages. To send data in VMS, you would fill a buffer with data and make a call to $QIO(W) (see part 2) using the handle of the mailbox you want to put the message into, a pointer to the buffer, and the size of the buffer (plus an eventflag, see part 2). To receive data, you would make the same call to $QIO(W), only the function specifier would be “read” instead of “write”. On return, the buffer will be filled with the received message, and the size parameter will be filled with the size of the received message.


  To send data in Linux, you would fill a buffer just like in VMS, but there must be an extra integer at the beginning of the buffer. This integer value must be filled with a number not being zero! Then you would call sndmsg() with the handle, a pointer to the buffer, and the size of the buffer – not counting the extra integer! To receive a message, you would call rcvmsg() with the same parameters plus a message identifier. This message identifier is used to filter the messages sent to you, so you get only the messages with the matching number in the extra integer value. If the message identifier is zero, there will be no filtering. For example: suppose there are five messages sent to you: message A with that extra integer set to 1, B with 2, C with 1 again, D with 3, and E with 2 again. If you start rcvmsg (...., 2), you will get message B first and then message E. Then rcvmsg (..., 3) will retrieve message D, and, eventually, rcvmsg (...., 0) will get the rest: A and C. If rcvmsg (...., 4) is issued, no messages will be returned. The message size, again not counting the extra integer, is returned as the result of the function.


  Another difference is that, in VMS, you must specify the total size of the mailbox when you create it. In Linux the size is fixed. This might be a problem when using large, or a huge number of, messages.


  The implementation


  In the beginning, I simply replaced every reference to mailboxes with the corresponding Linux calls. I used the specified logical as the name of a dummy file in a dedicated folder to get the unique key. For a small project, this would be acceptable, but this is not the intention of this migration tool. So I created the functions _CREMBX and _QIO(W) to behave the same as in VMS. (A “$” sign is not allowed in names when using Free Pascal, so my conversion program substitutes the “$” by an underscore. The same problem arose when using the terminal, I will discus this in part 5 about DCL).


  _CREMBX uses a dedicated logical to point to a file containing info about assigned numbers. This file is also used for creating the unique key. _CREMBX assigns a free number in the range 0-255 if the mailbox does not already exist. The given logical in table LNM_PERMANENT_MAILBOXES is used or created just like VMS would. Then the mailbox is linked to or created using the key, and the handle is returned.


  The _QIO(W) will send or receive depending on the function specifier. It uses a new thread and the specified eventflag to create the asynchronous behavior as in VMS (see part 2).


  This way, the only thing you would have to do for the migration is define the above mentioned dedicated logical and add the extra integer in front of the declaration of the buffer.


  Removing the logical used for a mailbox would cause the creation of a new mailbox upon opening, while the still connected processes would use the old one, exactly like in VMS.


  File version numbers


  This part is about file systems: In the beginning, there was DOS (and CP/M) which used FAT as its file system. File names were 8 characters long with a file type of 3 characters. Later, NTFS (New Technology File System) offered long names and types,and more attributes for better security. They were both using assigned drive letters to identify the device (disk).


  In Linux, most of the time “Ext” is used as its default file system, currently Ext4. As mentioned in part 3, Linux does not use assigned drive letters, but mounting points. From a functional perspective, that’s the only difference to FAT/NTFS.


  When DEC created ODS-2 (On Disk Structure version 2), it took a different approach. They named all devices (not just disks) with two characters to specify the type, one character starting with A, then B and so on to identify the adapter, plus a serial number. The base folder (directory) on a disk is named [000000] and names and types of files are long like in NTFS and EXT. And they decided that there should be more versions of the same file in the same directory (folder). An example:


  Suppose I create a text file with an editor and save the file. Besides the name and type that I specify, it will also get a version number, starting with “1”. If I would use the editor to change this file and save it again, the existing file will not be overwritten like in Linux and Windows. The editor creates a new file, with the same name and type, but with a higher version number, “2” in this case. The same happens with log files, executables (programs), and so on. The advantage is that you can see the history of a file and even restore a previous version. For example, if a new version of a program does not work as it should, you can just kill the process and start the previous version, it is still there (unless you deleted it). But of course there is also a down-side: For a thousand versions of a file, you need a thousand times the disk-space and the version is limited to 32767. If you go beyond that, the creating program will crash!


  If your project is depending on this behavior (the file version, not the crashing), you will have to change your programs. Either by adding a “version number” to the name or type, or by changing your project in such a way it will no longer depend on the file versions. Whichever solution is best depends on the project and there's no single solution that fits all possibilities.


  Packed array of chars


  In Free Pascal, two worlds collide. On the one hand are the C-type strings, and on the other the Pascal-type strings. C-type strings are either a pointer to a data-structure which can dynamically change in size, or a data-structure of fixed size, starting with a byte containing the length of the string. Both contain a zero terminated number of characters. Pascal-type strings are essentially just another fixed size array, without the terminating zero. In VAX-Pascal, there is a variant that uses a length word in front of the array (VARYING OF CHAR), but Free Pascal does not recognize the keyword VARYING. You will have to use fixed size C-type strings to replace a VARYING, but the behavior is not exactly the same. For this type of strings, the migration will need some work.


  Big problems arise when you compare two strings with at least one of them being a packed array of chars. In VAX-Pascal, the remainder of a packed array of chars will be filled with spaces, in Free Pascal the remainder is unknown! As a result, comparing even fails if the strings you use are equal. Suppose you have a packed array of chars with size 10 ([1..10]) named STR. Now fill it with a text of size 4 like “STR := 'test';” and compare it with the same text: “IF STR = 'test' THEN …. ELSE …..”. Both should be equal, but it will execute the ELSE part! This is a problem for a constant type of string, but it will also fail if you use a C-type string to fill a packed array of chars.


  This is clearly a bug, but I didn't have the time to fill out a bug-report.


  As a workaround, you could add a string of spaces with the same length as the size of the packed array of char, because Free Pascal will not complain about the string being too long. It just truncates it. So “STR := 'test' + ' ';” would fill the remainder with spaces as in VAX-Pascal, but this must be done with every assignment concerning a packed array of chars! You also have to do something similar when comparing. Lots of work to get around this behavior, so it might be easier - if possible - to switch to another type of string. But then there will be problems with code depending on the size of the packed array of chars, being not the size of its contents.


  There will be also problems when assigning a C-type string from a packed array of chars. If the remainder of the packed array of chars are zero's (usually the case) the contents of the string will list as “test” in the above example in the debugger, but the length of the string will be 10, so a comparison to “test” will fail. In the debugger, it looks like they are the same, but still the “if” statement will execute the “else” part. It took me days to figure that out. It shows an inconsistency in the way Free Pascal handles strings, as the terminating zero is ignored. Worth a bug report!


  Next month


  In the next article, I will go more in-depth about DCL (Digital Command Language) – the interface used by Digital when interacting with the terminal, and AST's (Asynchronous System Trap), also named ‘call back routines’, and, related to that, catching the signals as a result of pressing ^C, ^Y, ^T or ^Z.


  
    After keeping VAX/VMS systems running for 30 years, Theo needed a new challenge and started from scratch with Linux to re-do every mistake he made all over again. You can email Theo at: info@theovanoosten.nl
  


  Thinking Outside The Cell


  John Eddie Kerr


  Last year, I created a member directory for the Ontario Courthouse Library Association, of which I am a member. Since all of the information is in a spreadsheet, I thought that it would not take too long to make a nifty little membership directory in LaTeX that was formatted to look good on a computer screen, tablet, or a smartphone; in short – convergence ready.


  You may have data that is in a database or spreadsheet that you would like to extract and display in a different format. This could be for a publication like the directory I made, or it could be information that you want to include in a larger LaTeX document. LaTeX can display fantastic looking tables if you want to do that. The more I worked on this and made Google searches on LaTeX and CSV, I found out just how versatile LaTeX can be with a CSV file. But for now, I want to create a directory from data in a spreadsheet.


  Since my data was in a LibreOffice Calc file, I clicked on File → Save as → All Formats BOX → Text CSV (.csv). With the aid of search and replace in my text editor, I was able to eliminate all of the commas by replacing them with a space. Then, after creating a preamble in my LaTeX editor, I copied and pasted my data into a LaTeX file and proceeded to insert the LaTeX code, line by line, until my data looked like this:


  
    \textbf{Wellington County Law Association}\\ 74 Woolwich Street Unit D\\ Guelph, ON N1H3T9\\ \href{https://www.openstreetmap.org/#map=17/43.54695/-80.24834}{Map} \\ 519-763-6365\\ 1-866-893-5220\\ 519-763-6847 (fax) \textit{{\tiny Call before you send a fax}}\\ \textbf{John Eddie Kerr}\\ Mon-Thur. 9:30-1:30\\ \href{mailto:lawlibwell@gmail.com}{lawlibwell@gmail.com}.\\ \index{Wellington LA} \index{John Eddie Kerr} \newpage
  


  I did not think that it would take a long time to do this, but, as it turned out, this ended up being a lot of typing, heck, it had way too many line returns “\\<enter>”. Even though the finished product was a success, I realised by the time I had laboured to the last quarter of the alphabet, there had to be a faster way to do this. I was working to make the code look easier to read for humans, which is good, but what if LaTeX and my computer did not need it to look that way?


  Let's go back to the spreadsheet and for the purpose of this article we will just look at the first three columns and we will insert an empty column to the left of every column so it looks like this:
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  Before we go any further, do a search and replace on the entire file replacing any commas with a bar “ | ” and a space before and after it. This is to give a new separation character between city and province so that “Guelph, ON” becomes “Guelph | ON”.


  Into the cells type in the code needed for each line of text:
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  Cell A has the code to begin the boldface format command “\textbf{“, cell C has the bracket to close the format code command started in cell A “}” with the line break code added as “\\”. Cells E and G have only line break code “\\”, but they could have more – for now I want to keep it simple.


  Save this as a .CSV file and open with a text editor and it should look like this:


  
    \textbf{,Wellington Law Association,}\\,74 Woolwich St.,\\,Guelph | ON N1H 3T9,\\
  


  Do the following search and replace steps:


  
    	replace each comma with a space


    	replace the “{ “ with “{“ so that the “{ Wellington looks like “{Wellington


    	replace the “ | ” with a comma.

  


  (It works in gEdit, but it did not in Geany for some reason.) We end up with this:


  
    \textbf{Wellington Law Association }\\ 74 Woolwich St. \\ Guelph, ON N1H 3T9 \\
  


  The advantage of entering LaTeX code this way is that you can copy and paste or paint the needed code for your file very quickly, for each column, instead of line by line like I did the first time around. You can start off by experimenting with a file made up of one row of data until you are happy with it, and then copy the code into the full data file.


  After the data is manipulated to look pretty, press Ctrl A to select all, Ctrl C to copy, and then paste it into a file that holds your preamble and then save the file as a .tex file. Then process it through your favourite LaTeX editor. To see what we can end up with, here is a page from the directory I made:
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  There are many different methods to take tabular data and process it in a table format. I want to emphasise that this process is a method to take spreadsheet data and display it in a non-tabular way.


  If the data that you have is in another program such as an e-mail client's directory, you can probably export the data as a CSV file and then import it into a spreadsheet.


  Let’s highlight some of the code I used to make this directory.


  
    \documentclass[10pt,letterpaper]{report}\usepackage[paperwidth=3.5in, paperheight=4.5in]{geometry} \usepackage[latin1]{inputenc} \usepackage{graphicx} \setlength{\parindent}{0pt} \usepackage{hyperref} \usepackage{makeidx} \makeindex \begin{document} \begin{titlepage} \textbf{OCLA Directory}\\ as of \today \end{titlepage} \newpage DATA GOES HERE (as above) \end{document}
  


  Here are some comments on the nifty code in the preamble:


  
    	\usepackage[paperwidth=3.5in, paperheight=4.5in]{geometry} - sets a page size that is ideal for hand-held devices


    	\setlength{\parindent}{0pt} - stops automatic paragraph indents


    	\usepackage{hyperref} - allows the use of hyperlinks for e-mail and web pages


    	\usepackage{makeidx}


    	\makeindex - This lets us index data on an index page with the \index{ } command

  


  And in the data itself:


  
    	\newpage - I added this to the end of every row, resulting in one record per page.

  


  This process turns LaTeX into a very fast and powerful tool for displaying spreadsheet data in a non-tabular way. It was one of those “A HA!!” moments when I realised that we do not always need to create a LaTeX source document that caters to the human eye, even though we create a beautiful looking document with code that looks like a dog's breakfast.


  However, after we produce a document this way, it may be advisable to keep the spreadsheet file that contains the LaTeX code as this will make it easier to edit the information at a later date. The code that we create this way does not look pretty in the LaTeX editor, but the end results look great.


  As for writing tables in LaTeX from spreadsheet data, LaTeX has all kinds of tricks in the lion's den and I will look into that next time.


  Until next time, enjoy exploring LaTeX.
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  Drawing with Inkscape – Part 48


  By Mark Crutch


  If there's one word that can stir up controversy amongst experienced Inkscape users, it's “filters”. Attitudes range from “they're bitmaps, and therefore bad”, through “it's easier to add filters to your image in GIMP”, right up to “filters are great”. I'll go on record as putting myself in the last group, but I would definitely extend the statement to add “(if a little slow and clunky)” to the end of it. So what are filters, in Inkscape terms? And why are they so divisive?


  In short, filters are part of the core SVG specification that offer a way to perform bitmap operations on your vector objects. Filters consist of a number of “filter primitives” that can be linked together to create a “filter chain” that produces the desired effect. They apply at the point that your elements are being rendered to a bitmap for display, export or printing, and operate at the same resolution as the output device. So, although they are pixel-based, they can be just as crisp and scalable as the unfiltered vectors in your drawing. It does mean, however, that they are purely a display feature and have no effect on the underlying geometry of your image – so they're of no use to anyone trying to produce drawings for use on a vector output device such as a vinyl cutter or laser engraver.


  Filters are also “live”. You can tweak and modify the parameters used in your filter throughout the life cycle of your drawing, whereas filters in a bitmap editor like The GIMP are usually fixed and permanent once they've been applied. This is both a blessing and a curse: SVG filters are incredibly flexible because you can change them as you go along; conversely they eat up a lot of processing power as they need to be re-calculated not only when you change their parameters, but potentially each time you pan or zoom. The performance penalty can be severe, especially when zooming far into your drawing, leading some users to avoid filters entirely, although the worst problems can usually be avoided by using a few simple techniques that I’ll describe in a future article.


  Finally, filters are rather unintuitive – and Inkscape's UI for editing them only makes this problem worse. The developers have included a great set of predefined filters, which was improved further in 0.91, but it's still useful to understand how to use the editor in order to tweak and extend them. So let's start by taking a look at the editor courtesy of the most common filter primitive: Gaussian Blur.


  Gaussian Blur (or just “Blur” from now on) is the most commonly used primitive – principally because it’s exposed directly in the Fill and Stroke dialog. Many people happily use the Blur slider in that dialog without ever going anywhere near the full Filter Editor, but it also provides a convenient mechanism for creating a “stub” filter chain that you can develop further. Of course you’ll need an object (or group) to apply your filter to, so begin by creating a text object, give it a nice bright fill color, then add a little blur using the slider in the Fill and Stroke dialog.
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  Now open the Filter Editor using the Filters > Filter Editor menu entry. If it opens in a pane within the main Inkscape window, I suggest dragging it out as a separate floating dialog. This will let you resize it to give you more space to work with – filter chains can quickly become long and some of the primitives have a lot of parameters to tweak.
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  The left of the editor is given over to a list of the filters in your document. Assuming you started with a blank drawing, you should see only a single entry here, given an automatically generated name along the lines of “filter1234”. That entry will have a mark in the checkbox, indicating that it’s the filter that’s in effect on the currently selected object. If you want to apply the same filter to another shape, just select that object in the canvas window, then check this box in the editor; you can use a single filter chain on multiple elements – which is useful when you want multiple text objects to share a single drop shadow, for example. Finally, in this section you can create a new filter from scratch using the “New” button at the bottom, or right-click on a filter entry to duplicate or remove it completely. You can also rename it from that context menu, but it’s usually easier to just double-click on the filter’s name and enter a new one. Giving slightly descriptive names to your filters makes it easier to keep track of the important ones as your drawing develops. For now, why not rename “filter1234” to “Blur”?


  With your filter selected, you should see a single entry in the list on the right of the dialog: Gaussian Blur. This is your filter primitive, and it’s this list that’s used to stack and combine primitives into chains. For now, click on the Gaussian Blur entry to select it, and then look to the bottom of the dialog where you’ll find its parameters. Gaussian Blur takes two parameters, but by default Inkscape locks them to the same value via the “Link” button to the right. By toggling that to un-link the parameters, you can provide different values for horizontal and vertical blur, providing the opportunity for “motion blur” effects that make it look like your object has moved in one direction. Note that the scales are labelled in units of “Standard Deviation”, whereas the slider in the Fill and Stroke dialog shows a percentage value. The former is used in the SVG spec, whereas the latter is probably more understandable for users who just want to add a little blur without going near the filter editor. Suffice to say that the two fields are just different representations of the same underlying value, so the fact that they usually hold slightly different numbers isn’t really a problem.


  If you're still on 0.48, and drag the sliders to the right, you may notice that the blur on the text starts to get cut off at around the 20% mark, and by the time you reach 50% it’s become a ghostly rectangle. You’ve just encountered one of the most common problems reported by users who take their first steps into filters, but don’t worry, it’s an easy one to fix. In principle, some filters – including Gaussian Blur – could continue off into infinity: mathematically speaking, a blur represents an infinite series of calculations, although the results quickly drop off to the point that the calculated values have no visible effect on the drawing. Obviously performing an infinite series of calculations isn’t possible for even a high-end machine, so the SVG spec allows for a window or cutoff to be defined, beyond which the rendering engine shouldn’t bother performing any more calculations. By default this cutoff is set to allow a 10% margin all around your filtered object, which is fine for a small blur, but clearly not enough as the blur value increases.


  The cutoff is adjusted via the “Filter General Settings” tab, and, as the name suggests, it affects the whole filter, not just the currently selected primitive. Within this tab you’ll find two sets of parameters, labelled “Coordinates” and “Dimensions”. The former sets the position of the top left of the filter window, relative to the width of the object. The default values of -0.10 mean that the cut-off rectangle starts 10% up and to the left of the object’s bounding box. The latter pair of values sets the width and height of the filter window, so the default value of 1.20 results in a cut-off that’s 20% larger than the bounding box. Because the Coordinates fields have offset the window by 10% to the top left, the result is a cut-off that symmetrically surrounds the original object with a 10% margin. To use a large Gaussian Blur value, you might want to increase this window to give you a 50% margin all round: that would entail setting the Coordinates to -0.50 and the Dimensions to 2.0. Most of the time you don’t need to adjust these values, but when you start to see your filtered objects being unexpectedly cut off at the edges, the Filter General Settings are almost always the cause.


  In the copy of 0.91 on my machine, this problem seems to have been addressed by automatically modifying the settings to sufficiently encompass the blur. However I can find no mention of this change in the 0.91 release notes, so it's not clear if this only applies to blurs or simple filter chains, or if the algorithm being used is robust enough to handle complex chains as well. Therefore I recommend familiarising yourself with this tab, even on 0.91 – though with luck you'll never have to use it.
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  Before moving on, it’s worth having a quick recap to make sure you’re clear about the dialog so far. On the left is the list of filter chains, each with a checkbox to apply it to the currently selected object. From here you can create new chains (though just adding some blur to your object has a similar effect), and manage existing ones. On the right is the list of filter primitives that constitute your filter chain – though so far we’ve only dealt with a rather short chain consisting of a single primitive. At the bottom of the dialog is a tab for the currently selected primitive’s parameters, and another for setting the filter cut-off window position and size.


  Now, let’s move back to the list of primitives that we so quickly glossed over previously. Looking more closely at the Gaussian Blur entry you’ll notice that the “Connections” section contains a barely visible triangle, from which is emanating a line that connects to a column on the right with a “Source Graphic” label running vertically down it. The triangle represents an input into the filter primitive, and the column is one of several possible sources for that input. Unfortunately, of the six inputs shown in the UI, two of them require special treatment (and will be covered in a future article), and another two don’t work at all! Of the two that do work, the “Source Graphic” column is exactly what it sounds like – it’s used to ‘inject’ a bitmap representation of the selected object into the filter chain. The “Source Alpha” column is used to inject a bitmap representation of the object’s alpha channel with solid black pixels representing opaque parts of the object, transparent black pixels for the transparent parts, and translucent black pixels for those parts that are somewhere in-between. In other words, it injects a blackened silhouette of the object.


  As well as having the triangular input nodes, each primitive also has a single output. There’s no obvious output node, instead it’s the bottom edge of the primitive that acts as the output in the Inkscape UI. It’s possible to connect the bottom of one primitive to the input triangles of other primitives, thus building a chain, but the output from the last primitive is always used as the output from the chain as a whole.


  Let’s build on our Gaussian Blur to create a simple drop shadow filter. During this process, you’ll learn how to link primitives together to form a chain, and hopefully begin to understand a little more of the power of filters. Start by renaming your existing filter to “Drop Shadow”, re-link the parameters if you need to, and set the blur to a fairly small number – enough that you can clearly see it applied to your object, but not so much that the it just turns into a fuzzy cloud. A value of 2-3 should do the trick.


  Our shadow is going to be dark, made of translucent black pixels, so the first thing to do is to generate a silhouetted version of our object to pass as an input to the Gaussian Blur primitive. But, of course, we already know of a source of silhouettes – the Source Alpha column. In a slightly back-to-front operation, we can link this source to the Blur’s input by clicking and holding on the triangle, then dragging the mouse to the Source Alpha column before releasing (yes, you drag from input to source, rather than the other way around). If all went smoothly, the line that previously ran to the Source Graphic column has been replaced by one to the Source Alpha instead. Take a look at your text object and you should find it’s turned into a blurry black version of the original.
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  If we were to display the original over the top of the blurred alpha version, you would just see a halo of darkness around your text. To make it work as a drop shadow we need to offset our blurred image from its original position using the imaginatively titled “Offset” primitive. Select it from the pop-up list just below the filter chain, then click the adjacent “Add Effect” button to add it to your chain. It should automatically be connected to the output of the Blur, as indicated by a small line running from the triangular input of the Offset to the bottom of the Gaussian Blur. Adjust the new primitive’s Delta X and Delta Y parameters to shift your shadow down and to the right – a value of 6.0 in each is a good start.


  The final step in creating our filter is to add the original graphic back on top of the blur using the Merge primitive. Once again you should select it from the pop-up list and add it using the Add Effect button, but this time it won’t be automatically connected to the rest of the chain. The Merge filter combines multiple input images by stacking them on top of each other, honouring any transparency they may have in the process. The first input goes at the bottom of the stack, the last input at the top, so we need to add the offset blur first and the original source graphic second.


  Begin by clicking in the Merge filter’s sole input triangle and then, holding the mouse button down, drag to the triangle in the row above (the Offset filter). Release the button and you should see a connection made, running from the base of the Offset to the input of the Merge. You’ll also notice that the Merge filter has gained a second input triangle. Click and drag from this second triangle to the Source Graphic column. Check the canvas, and you should now have a glorious drop shadow. See, filters aren’t so tricky… right?
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  Now tweak the Gaussian Blur and Offset parameters to change the softness of your shadow or its relative position. Then edit the text itself. Each change you make takes place live, and you can re-open the filter editor at any time to make further changes. Try creating a “hard” drop shadow by merging an offset Source Alpha with the Source Graphic, but without using the Gaussian Blur. Or try a bit of motion blur by un-linking the horizontal and vertical sliders; adding some horizontal blur and a horizontal offset; then merging with the Source Graphic again.
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  Make sure you understand what we’ve covered in this instalment, because, next time, we’ll build on this simple drop shadow to introduce some more filter primitives that will expand your repertoire further, giving you the capability to achieve effects that just aren’t possible without a little smattering of bitmap magic on your vector objects.


  
    Mark uses Inkscape to create three webcomics, 'The Greys', 'Monsters, Inked' and 'Elvie', which can all be found at http://www.peppertop.com/
  


  [image: Cover]


  Arduino


  Not much left to do on the Brewduino now.


  I’ve added some LEDs just to indicate what’s going on. The green LED is to show that the device is on and OK. The red LED shows that the switch is on and, thus, the heat mat is on and heating up the fermenting vessel. Finally, the blue LED shows that the switch, and heat mat, are off, and that the vessel is cooling down to room temperature.
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  The best way, I found, to test the whole device is to have the DHT22 under the lamp because, when the lamp comes on, the heat from the bulb will bring the temperature up and the whole system goes into an on/off cycle. The lamp heats the DHT, and when it goes off, the DHT cools down, the threshold is reached, and the lamp comes back on again. And so on.
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  The only adjustments to the code are to define the LED pins:


  
    int power = 43; int red = 47; int blue = 39;
  


  Then, set the modes to output, and put the (power) green LED on:


  
    pinMode(power, OUTPUT); // LED pinMode(red, OUTPUT); // LED pinMode(blue, OUTPUT); // LED digitalWrite(power, HIGH); // power on LED
  


  The temperature check statement now includes the states for the red and blue LEDs:


  
    if (DHT.temperature > 24 ) { state=HIGH; // switch heat mat on digitalWrite(red, LOW); // heating on LED digitalWrite(blue, HIGH); // heating off LED } if (DHT.temperature < 24) { state=LOW; // switch heat mat off digitalWrite(red, HIGH); // heating on LED digitalWrite(blue, LOW); // heating off LED }
  


  You’ll note that I’ve also fixed the SSR state so that the light is LOW (on) when the temperature is below 24, and HIGH (off) when above 24. This is the correct procedure for the heat mat.


  Well, we’ve pretty much come to the end of the Brewduino. Apart from swapping out the lamp for the heat mat, everything is in place and working. Obviously, everything will need to go in a nice box, and the Arduino will need a power supply (as I need my laptop!), but everything is working, and that’s the main thing.


  No doubt I’ll be tinkering with the code between writing this up, and you reading it, but the code referred to here is at: https://gist.github.com/ronnietucker/7fc62df161107116cf93, and marked as revision 6.


  If you can think of anything to add/change in the Brewduino, please feel free to email me your suggestions: ronnie@fullcirclemagazine.org


  
    Ronnie is the founder and (still!) editor of Full Circle. He's a part-time arts and crafts sort of guy, and now an Arduino tinkerer.
  


  Chrome Cult


  by S J Webb


  In the past, I have reviewed cloud-based distros. The Chromebook is very difficult to wipe from the SSD. There are various means to incorporate Ubuntu into the framework. The first attempt was Chrubuntu, Crouton, and the Gallium OS. I purchased an Acer C720 to experiment with Crouton and Gallium. This hardware is known for compatibility with Crouton and Gallium. When I logged into the Acer, the screen top was a perfect duplicate of my Toshiba. Even my Chromebook settings live in the cloud, which is slightly unnerving.


  Chrubuntu runs off a dedicated USB or SD card. It acts like a regular full operating OS. The developer installed all of the hardware drivers and items for Chrubuntu. It is supposedly easier to install. It appears to be an abandoned project. You can find instructions on how to install it on the web. The Chrubuntu community is thriving. Previously, I installed Chrubuntu on an Acer C710, and I was not impressed. The trackpad was inactive and the system seemed slow since it was running from an SD card. Perhaps at that time Chrubuntu was in beta testing or my hardware was not complementary. Chrubuntu works as a true dual boot for the Chromebook.


  Crouton uses a root environment. This allows Ubuntu to run parallel with the Chrome OS. There would be no need to reboot to move between the two operating systems. It was easier to get Crouton installed. There are only three available DEs: Unity, XFCE, and KDE. I attempted LXDE and failed. My version had Ubuntu 12.04, there are ways to install 14.04 for the root environment. I followed the directions at www.linux.com by Swapnil Bhartiya on installing Crouton. David Bennett at www.davebennett.tech offers simple steps for the 14.04 installation. He also gives instructions on how to install Kodi to your Chromebook.


  The Gallium OS just left beta testing. It is based on Xubuntu. Gallium does not use a root environment, but allows for dual booting. The installation is well documented. I was not able to boot Gallium onto the Acer Chromebook. It was a simple fix – by modifying part of the Grub code per the Gallium website (modify a memory code line). However it appears to be the most popular method of putting Linux onto a Chromebook. The Gallium developers appear to be driven in making this a successful OS.


  A final option on a Chromebook is to change the BIOS to SeaBios. Only certain Chromebook models can utilise SeaBios. This modified BIOS enables a person to wipe the Chrome OS off the Chromebook and boot a Live USB to install another OS. In some cases some people are installing a Windows OS despite the lack of mouse and keyboard drivers. You can discover this method from a single internet query.


  The past couple months I reviewed the various cloud-based distros and Linux environments for the Chromebooks. In my humble opinion, there is an open source solution to the closed Chrome OS developed by Google. The solution is not the easiest to implement though. If a person wants to avoid the Chrome OS, he or she should purchase a cheap laptop, then install Peppermint OS or Apricity OS. However a person can learn numerous items when installing an open source solution. Every cloud-based distro offers perks and problems during the course of OS discovery.


  At the end of the day, I use a Chromebook for the Chrome OS. Ultimately, I want a simple, reliable, and secure device. Linus is a fan of Chromebooks and how it brings Linux to the masses.


  Below are the steps, in order, to install Crouton.
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    SJ Webb is a Linux Hobbyist and Research Coordinator. He enjoys fishing, hot rodding, and spending time with his kids and wife. He thanks Mike Ferarri for his mentorship.
  


  Write For Full Circle Magazine


  Guidelines


  The single rule for an article is that it must somehow be linked to Ubuntu or one of its many derivatives—Kubuntu, Xubuntu, Lubuntu, etc.

  

  Write your article in whichever software you choose—I would recommend LibreOffice. But, please spell and grammar-check it!

  The Official Full Circle Style Guide can be read at: http://url.fullcirclemagazine.org/75d471

  

  Please read this document before submitting an article. Follow the guidelines and you will have a much better chance of seeing your article in Full Circle.


  Writing


  There is no word limit for articles, but be advised that long articles may be split across several issues. In your article, please indicate where you would like a particular image to be. Please do not use any formatting in your document.


  Images


  Images should be no wider than 800 pixels, in JPG format, and use low compression.

  

  When you are ready to submit your article, please email it to: articles@fullcirclemagazine.org


  Non-English Writers


  If your native language is not English, don't worry. Write your article, and one of the proofreaders will read it for you and correct any grammatical or spelling errors. Not only are you helping the magazine and the community, but we'll help you with your English!

  



  FOR REVIEWS:


  Games/Applications When reviewing games/applications, please state clearly:

  • title of the game

  • who makes the game

  • is it free, or a paid download?

  • where to get it from (give download/homepage URL)

  • is it Linux native, or did you use Wine?

  • your marks out of five

  • a summary – with positive and negative points

  

  Hardware When reviewing hardware, please state clearly:

  • make and model of the hardware

  • what category would you put this hardware into?

  • any glitches that you had while using the hardware?

  • easy to get the hardware working in Linux?

  • did you have to use Windows drivers?

  • marks out of five

  • a summary – with positive and negative points

  

  You don't need to be an expert to write an article – write about the games, applications and hardware that you use every day.


  Linux Labs - Debian Noroot


  by Ronnie Tucker


  Not everyone can get their hands on an Ubuntu phone, but now, if you have an Android device, you can have Debian on your phone/tablet!


  Head over to the Google Play store and search for ‘debian noroot’ and it’ll come up. Alternatively, click this link: https://play.google.com/store/apps/details?id=com.cuntubuntu


  [image: noroot01]


  Click the INSTALL button and wait. It’s a touch over 200MB, so it may take a little while.


  When the install is done, you’ll see a Debian logo on your desktop. Give it a prod to start the next install. This will take a few minutes – depending on your device.
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  Once that’s done, you’ll see a startup screen (with some information). It’s a bit quick at vanishing, but it’s reproduced here to let you see the basic commands:
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  Now you’ll have a fully working Debian desktop on your Android device!
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  By default, there’s no software, to speak of, installed. So, click the ‘Terminal’ icon. To get the keyboard up, you have to press your device's ‘back’ button. The first thing to do is update your package list (by default, it’s empty): Type:


  
    sudo apt-get update
  


  Then, to install a web browser, enter:


  
    sudo apt-get install inceweasel
  


  [image: noroot06]


  Now we’re ready to rock!
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  I’ve only scratched the surface of what’s possible with Debian Noroot. Other folks have SSH, GIMP, and all sorts of other stuff installed on their Android devices.


  
    Ronnie is the founder and (still!) editor of Full Circle. He's a part-time arts and crafts sort of guy, and now an Arduino tinkerer.
  


  Testing and troubleshooting hard drives


  By Charles McColm


  Several years ago, I bought a number of new components from an online retailer only to discover some of the equipment was bad. I figured since the hardware was new and in the sealed packing when I bought it, I wouldn’t have any problems. Whether you’re building a new system or refurbishing an old one, it’s always a good idea to test your hardware. Since hard drives are most people’s permanent storage, having a healthy hard drive is almost as important as good steady power to the computer.


  In the past, our refurbishing project has used a few methods to detect bad drives: The first method was just listening to the drive. If the drive sounded whiny (or had the notorious click of death), we either wiped the drive with DBAN (Darik’s Boot and Nuke - http://www.dban.org/), or took apart the drive and sent it to our end-of-life processor. The second way we knew a drive was bad was if it failed DBAN. This method wasn’t foolproof because drives with bad sectors could fully DBAN. Sometimes our volunteers would forget to hook up the data or power cable, so the drive wouldn’t be detected and would also fail DBAN. The last method was to examine the hard drive using Gsmartcontrol. Gsmartcontrol is great because it can instantly detect certain kinds of SMART (Self-Monitoring, Analysis and Reporting Technology) errors. Unfortunately, SMART isn’t perfect. Wikipedia has an excellent article covering SMART that mentions that in one study more than 50% of drives that failed did so without triggering one of the main SMART failure indicators.
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  To augment our SMART testing, we’re starting to use WHDD, a tool ported to Ubuntu by Eugene San. WHDD bills itself as a hard disk drive diagnostic and recovery tool. What we like about WHDD is that it can run a disk read surface scan fairly rapidly. Smartmontools and Gsmartcontrol can be used to run a short (approximately 2 minute) electrical and mechanical test, but the short test covers only a small part of the drive. Both tools can also be used to run a Long/Extended test which scans the entire surface of the drive, but the Long test is as the name describes, long. Even small (80GB) hard drives can take several hours to scan.


  This is where WHDD comes in handy. WHDD can run a complete surface READ scan on an 80GB hard drive in under 22 minutes (17 minutes on one of our Seagate drives). Our larger 3TB drive (which was completely full of data) finished in 245 minutes. Here’s a small sampling of the time/size ratio we found for different drives we measured.
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  The ETA is an approximate Estimated Time of Arrival (finish) WHDD displays at the beginning of the test. For the most part, the ETA, unlike many time indicators, is fairly accurate – to within a few minutes. But, like other time indicators, it does suffer time creep when the test comes across several slowly read sectors. We tested several drives and found the average time for an 80GB hard drive to be about 22 minutes.


  The Speed of the drive is a fluctuating number. In general, we found the larger the drive the higher the speed. This makes a lot of sense since newer drives should have faster technology to read the surface of larger sized drives. We tested 15 drives of different sizes and makes, and found (with the odd exception) the trend of faster speed seems to correlate with size. Drive content didn’t seem to affect the numbers as much as the number of slowly read sectors.


  During the read test, WHDD charts the number of blocks read at each of the following speeds: <3 ms, <10 ms, <50 ms, <150 ms, <500 ms, > 500 ms. If you see a lot of blocks in the <500 ms range and > 500 ms range it’s a really good idea to back up your data and switch to a drive with better read times. Here’s a small sample of read times for the same drives:
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  In the example, the Western Digital WD5000AAKS-65V0 500GB hard drive has 3 blocks in the above 500 millisecond and 22 blocks in the between 150 to 500 millisecond range. If you’re concerned about your drive being fast, or worried about bad blocks, this might be a good indication that it’s time to back up and replace the drive.


  But what about data? Does the amount of data affect the time data is read by WHDD? In these charts, all the drives were blank with the exception of the 3TB Seagate ST3000DM001-1ER166 which was almost full of very large files (20GB+ files). Although it took the longest to read, it’s also 6 times the size of the 500GB drive. If we take the 90 minutes of the 500GB drive, and multiply it by 6, we get 540 minutes, almost double the time the 3TB actually took to read. From this we can conclude that WHDD doesn’t seem to be affected much by the amount of data on a computer (it also helps that newer drives are simply faster).


  WHDD is a command line tool and needs sudo permission to run:


  
    sudo whdd
  


  WHDD can show SMART attributes, run a read test, run a copy test, run a write test, or set up a host protected area (HPA), a hidden area of the drive an OS can’t normally read. WHDD doesn’t do the kind of SMART short test that Smartmontools or Gsmartcontrol does, but one of the neat things that WHDD might tell you (when looking at the SMART attributes) is if the hard drive has a firmware update available.
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  Read, Copy and Write tests are all visual. As each block is read/copied/written, it’s displayed much as you’d expect a block read/copy/write test to display, as a block. Quickly read blocks are mostly black with a tiny bit of grey, blocks up to 50ms access time are still grey. Blocks under 150ms access time are green. Blocks over 150ms are displayed in red and blocks over 500ms are displayed in bright Salmon color. Errors are indicated by what looks to be a small bug.
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  At any time during a test, you can stop the test by pressing CTRL+C. To get back to the WHDD menu, press m (after aborting the test with CRTL+C).


  WHDD is a great tool when SMART doesn’t tell the whole story. SMART can tell you a lot about a hard drive: it can tell you the number of hours in use, whether a sector has been reallocated, even if the system has been suddenly shut down, but it doesn’t always help when a drive is simply slower than you might expect. This is where WHDD can be a great tool.


  Of course there is no substitute for a good backup. More than any other tool, a good backup can save you the most grief. Whether you’re a system administrator or just storing terabytes of music and video on your home media server, you want some kind of backup to ensure your data (and effort) doesn’t disappear if a drive fails.


  Alan Ward wrote an excellent article on backup using rsync in issue #83 of Full Circle Magazine: http://fullcirclemagazine.org/issue-83


  In summary: if you’re just checking out blank drives, listen first – if a drive sounds bad, but tests good with a SMART tool like Gsmartcontrol or Smartmontools, give it another quick read test with WHDD. If you’re worried about data on a drive, back it up first with rsync (or dd if you have an identical or larger drive to copy to), then check with one of the SMART tools and WHDD to get a better overview of what’s going on with your drive(s).


  GSmartcontrol: http://gsmartcontrol.sourceforge.net/home/


  Smartmontools: https://www.smartmontools.org/


  WHDD: http://whdd.org/

  


  
    Charles McColm is the author of Instant XBMC, a short book on installing and configuring XBMCbuntu (a *buntu+XBMC distribution) - still relevant for Kodi, and the project manager of a not-for-profit computer reuse project. When not building PCs, removing malware, and encouraging people to use GNU/Linux, Charles works on reinventing his blog at http://www.charlesmccolm.com/.
  


  Ubuntu Devices


  OTA-10


  We have a summary list of updates made for OTA-10 below.


  The following apps are now pre-installed by default:


  
    	Email app (Dekko)


    	Calendar app


    	uNav

  


  General enhancements:


  
    	New theme and color palette


    	Updated OOBE (Out Of Box Experience – provides a better initial setup experience for new users)


    	Updated Edge tutorial


    	VPN support added to Settings


    	New system indicator with desktop mode toggle for convergence


    	Updates can now be downloaded over 3G


    	Control added for external mic volume

  


  A complete list of changes can be found at: https://wiki.ubuntu.com/Touch/ReleaseNotes/OTA-10


  NOTE: There has since been a quick update to this with the release of OTA-10.1 to fix a small security issue which was discovered after the release of OTA-10.

  


  BQ M10 Tablets Now Shipping
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  BQ have been sending out emails letting buyers know that the M10 tablet has begun shipping. Some people have already received their tablets, and a couple of reviews have sprung up online.
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  Review - Linux Lite


  by Art Schreckengost


  Looking for a light Ubuntu-based distro that won’t break your hard drive?


  How many times have your heard that pitch and then discovered that light usually means stripped or sorely lacking in necessary components and codecs?


  Enter Linux Lite 2.8 from New Zealand. Based on Ubuntu 14.04 LTS (Trusty Tahr), it carries a feather logo that may seem somewhat familiar to Linux oldsters like myself -- it’s the same one carried by the now deceased U.K. based Feather Linux (R.I.P. 2006).


  And that’s where the similarity ends. Feather was Knoppix/Debian based, carried a Fluxbox desktop, and was a super lightweight at shy of 125MB. In comparison, Linux Lite packs a much heftier 800MB package.


  The website (https://www.linuxliteos.com) claims its OS is “Simple Fast Free”, so let’s put it to the test (yes, I know the punctuation is lacking, but it is on the website, too).


  As for the simple aspect, LL (what I’ll call Linux Lite from here on) is not only small in size but will be quite happy with minimal-spec systems. With a base requirement of just 700MHz and 512MB RAM, this should work on just about any PC made after 2000 (truthfully, they do recommend at least twice that much horsepower and RAM for smooth operation).


  Guess my decade-old Dell Core Duo pushing 3GB RAM should fit the bill.


  Of course, it’s obviously free, but is it fast?
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  Well, that depends. If you plan on using the Live version off a DVD or USB/flash drive, it won’t be any quicker than any other similar offering but that has always been a drawback to Live systems.


  Those opting for a full or VM install will be happy to see the usual Ubiquity installer. A few clicks and keystrokes, and you’ll be ready for setup which takes roughly 20 minutes (faster if you use a USB/flash drive instead of a DVD).


  Cold boots are nothing spectacular at around 20 seconds on my decade-old Dell, but I did find it odd, that’s with a GRUB boot delay of 0. Hmmm, that may take some work.


  In keeping with the minimalistic theme, the desktop consists of a bottom taskbar with the usual system parameter icons, and a menu button along with the feather logo on a grayish background. Nicely presented while still being functional.


  Ah, but here is where things get interesting. After every boot, at least until you tell it otherwise, you’ll get the “Welcome to Linux Lite” pop-up screen, a rather ingenious way of handling basic system needs.


  Unlike Mint’s welcome screen, this one actually contains information I found useful after the first few boots (sorry, Mint, but it did become repetitive until I pulled the plug).


  Inside this box you’ll find headings for updating and upgrading both the system and software, plus there’s another section for the installation of “Lite” software to include Chrome, Chromium, Tor, Dropbox, Kodi, Skype, Teamviewer and Virtualbox.


  This makes updating and upgrading a simple one-click affair instead of waiting for the system to dump a 500MB surprise in your lap at some future date.


  As for the Lite software programs, this must be partially built in to the system because installation was a whole lot easier than downloading them individually via Synaptic. I’d be exaggerating if it took any more than 5 minutes to download and install all of those programs mentioned above.


  As for software installation, you also find another neat program minimally titled “Lite Software”.


  Although the box itself seems simplistic and somewhat crude by design, it’s effective for its intended purpose -- installing roughly 15 to 20 of the most often used or requested programs.


  For other programs, there’s the Synaptic Package Manager which, in this case, is renamed “Install/Remove Software” (but when it comes up, the header clearly states Synaptic).


  The desktop is utilitarian Xfce all the way. If you’re looking for visual pizazz and gizmos galore, you might prefer another distro. It’s functional while not looking ugly in the process.


  For such a lightweight package, LL does come with quite a few standard programs such as:


  
    	Firefox (with options to install Chrome and Chromium).


    	LibreOffice 5 (I mention the number since other distros I’ve tried have older versions) with Evince as the PDF add-on.


    	Thunderbird for email.


    	The GIMP and Image Viewer.


    	xfburn for CD/DVD production, Clementine and VLC for media playback.


    	The standard pot of accessories such as calculators and screenshot packages.


    	Lite Tweaks, a program that cleans the garbage out of your system without having to rely on somewhat questionable outside programs that may do more damage than good. If you’re wondering, no, it’s not related to Ubuntu Tweak.


    	Systemback, a unique one or two-click backup that can create a live version of your setup without having to install anything else.
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  Not a bad selection for what should be a light, limited distro.


  Even more impressive is that after adding a load of personal program choices plus the built-in offerings, my HDD is down just 7.1GB.


  Once you get everything loaded to your liking, the system is not only highly functional and stable, it’s quick to perform also. In fact, the only time I experienced a slowdown was when I used Systemback for a complete ISO image (that did hijack my system for roughly 15 minutes), but I expected that.


  That isn’t to state that’s in all hunky-dory here, folks. There was an odd failure to communicate when I went to use the Lite Software package after a couple days of system usage. It developed a tick in the software sources list and gave me an update error based upon the “trusty/main” archives. As such, Lite Software hasn’t worked since.


  That’s definitely going to need a workaround although most users will probably click over to other sources such as the Install/Remove Software mentioned before.


  So, what’s the final consensus on Linux Lite? Personally, I found it to be just as functional as other lightweights in the Ubuntu family, including Lubuntu and Xubuntu. However, LL has more included programs and is more aesthetically pleasing (it may be a near-barebones OS but it doesn’t look like such).


  True, it has a couple quirks and may need a little tweaking, but I’ve experienced a whole lot worse in my day.


  In the end analysis, it has a small footprint, some great tweaks, and operates better than most in the class.


  Give it a try and I’m sure you’ll agree.


  Q&A 108


  Compiled by Gord Campbell


  
    	Q I installed Viber from the Viber web site, but it doesn't run.


    	A (Thanks to howefield in the Ubuntu Forums) Try installing libgstreamer-plugins-base0.10-0


    	It looks like the package creators have missed referencing a dependency (or the dependencies have changed) from their package.


    	Q Is there Linux software which will read and work with PowerPoint files?


    	A (Thanks to linuxkvh in the Ubuntu Forums) Try LibreOffice Impress. Minor compatibility issues might happen when loading PowerPoint presentations, so it's best to use only LibreOffice when working on a new presentation.


    	
      A second option is to use MS office under Wine.


      marseille2 suggests WPS Office, which he says is particularly good with PowerPoint files.

    


    	Q I have 4GB of RAM and only 2GB are available.


    	A After swapping RAM sticks around, it became apparent that two of the four slots were not working. The Original Poster also noticed "a bulged up capacitor", so it's a hardware problem.


    	Q I'm using Ubuntu 14.04 on my Asus X205T. Yesterday the updater installed some stuff and asked to restart; I said ‘later’. The next time I started up, the touchpad doesn't work at all.


    	A (Thanks to sudodus in the Ubuntu Forums) Some computers have a button to turn the touchpad on and off. Maybe you can check if you can turn it on with a hotkey combination, maybe the 'Fn' key + an 'F' key. My laptop has the Fn + F5 key combination for this purpose. One alternative is to boot a previous kernel via the grub menu (press the shift key during boot if you don't see it).


    	
      And the previous kernel solved the problem.

    


    	Q I installed my new computer with Ubuntu 12.04.4. When I start up the computer, I get one notification of "Network Disconnected - you are now offline". The Ethernet port does not appear in ifconfig output.


    	A New computer, old OS, bad outcome. Try 15.10. (Which worked.)


    	Q I am using gadmin-samba to configure shared folders, but it's not working.


    	A (Thanks to bab1 in the Ubuntu Forums) I can't stress this too strongly -- DO NOT USE Gadmin-samba TO CONFIGURE A SAMBA FILE SERVER. Purge everything to do with gadmin-samba, and start over. Setting up a simple file server is not very difficult.


    	Q Is there a way to notify users of password expiration at logon?


    	A This does not answer your question, but it should be relevant: most security experts now feel that having passwords expire is a bad thing, which actually reduces security.

  

  


  Top questions at Askubuntu


  * Unable to find the .lit file reader conversion app clit http://goo.gl/9dTGfd


  * Moving entire Linux installation to another drive http://goo.gl/k7BrZC


  * Does rolling back the kernel in Ubuntu compromise security http://goo.gl/BNZdKF


  * How to stop the pointer jumping around due to the touchpad? http://goo.gl/7Mo4N3


  * Which package is the command 'cd' in? http://goo.gl/zfrmXi


  * How do I run a sudo command needing password input in the background? http://goo.gl/a3OPnq


  * I have a file named "-t". How to remove it? http://goo.gl/vfjoL7


  * Why won't this script run on startup? http://goo.gl/mn3ezn


  * How to add accents, etc, to letters using the "English (UK)" input source? http://goo.gl/sLCmkM

  


  Tips and Techniques


  Information, Please


  Activity in the Ubuntu Forums has dropped by half over the past few years, which is probably a good thing, since it means that fewer people need help.


  However, I have noticed that a lot of the people who ask for help provide about 10 per cent of the information that anyone would need to help them. At the risk of repeating myself, I would like to make some suggestions.


  It's almost always relevant to tell people what version of Linux you are using. For example, "Xubuntu 15.10 64-bit". There's no single way to get this information which works across various versions of Linux, so you should write it down when you download it – if there is any chance you will forget.


  It is often relevant to tell people about your computer. In order of relevance: memory, video adapter, CPU, and hard disk size and layout. And sometimes, the Wi-Fi adapter or audio device. My favorite program for getting this information is lshw, which can provide nicely formatted details about your system:


  
    cd Desktop sudo lshw -html > myconfig.htm
  


  Identify the application, if you have a question about it. It's not "my backup program," it's "rsync". (Or whatever.)


  If you have a question that involves a website, identify it. "I have a problem playing video 156015647 on vimeo.com" is a lot more useful than "I have a problem playing online videos".


  If you get an error message, the exact message is obviously relevant. If you can't record it any other way, take a picture with your cellphone.


  Then there's one more step: put the organized data into Google! My best Google queries have used four words, but you need to think about what four words are most relevant. My personal experience is that I almost always find the answer, so I don't need to ask a question.
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  Ubuntu Games - GoPanda


  By Ronnie


  Having watched the AlphaGo and Lee Sedol matches via YouTube, I decided to buy a couple of books and give Go a try.


  I managed to easily find a couple of Go apps for Android, but had difficulty finding a good piece of Go software for Linux. Eventually I came across GoPanda.


  GoPanda is basically a front-end for IGS PandaNet (aka: Panda Network) that allows players to watch, play and discuss Go. The software can also let you review Go games using the SGF file format. While having Java-based software may make some people groan, at least it allows Linux users to get involved in playing Go.


  Registering


  Head to the PandaNet site at: http://pandanet-igs.com/. In the right-hand-side column, there’s a button saying ‘Register’. Click that. Or you can click the big ‘Play on Pandanet!’ button to get a popup with a registration button.


  Fill in the details such as username, password, email, etc.


  Finally, click ‘Register’, and wait for a confirmation email. Since the confirmation email can sometimes take a little while, let’s get installing.


  Installing


  First thing to do is grab the archive file from: http://pandanet-igs.com/communities/gopanda2/100/


  For using the software there’s also a PDF manual at: http://www.pandanet.co.jp/top_newsph-igs/GoPandasmanual.pdf


  Unarchive the .tar.gz file to somewhere, and open that newly created GoPanda2 folder. In there, you’ll see an icon called GoPanda2. That’s the executable to run GoPanda. Double-click it and you’re off and running!


  On the first run, the software will update itself.


  Playing


  Top right, in the GoPanda window, is the login button. You’ll need to log in to connect to PandaNet:
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  You’ll now be in the main room with a list of currently playing matches. You can click on one of these matches, and, from the popup menu, choose ‘Observe’.
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  You are now watching the match... live.
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  Everything in GoPanda opens like browser tabs, so clicking the X in the game tab (below the GoPanda logo) lets you leave the game.


  So, now you’re back to the main room. Now what? Well, if you’re like me and don’t want to just dive in and get soundly thrashed by a pro, you click the drop-down menu (in the main room) and choose ‘Beginners (Robots)’. This opens a new tab with people playing robots.
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  But, on the right hand side (where it lists players), you’ll see players named Robot. They’re available for games. Most are 12k+, which means they’re more than enough for a total noob like me.


  Click a robot name, choose ‘Challenge’, and you’ll get a popup with some game settings. Things such as rules, board size, handicap/not, time, etc. Finally, click OK.


  Don’t be surprised if it says the player is already in a game. This happens when someone jumped in before you to challenge that robot. Try another robot. TIP: check the games in progress on the left to see which robots are currently in use.
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  So now you know how to observe and play on PandaNet. But there’s more! You can click on a player's name to view their stats, send messages, add as a friend, and (best of all) you can click ‘Game archive’ and see a list of their past games. From that list you can then observe (or download) the game to watch it step-by-step.


  Go On The Go


  For Go, on the go, there’s also Android and iOS apps for GoPanda. Android app: https://play.google.com/store/apps/details?id=be.gentgo.tetsuki&hl=en_GB (sorry, I’ve no iOS device for an app link).
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  Don’t Forget Patreon


  By Ronnie - Jan 4, 2016


  Just a quick reminder that Full Circle is still on Patreon. Everything from Patreon helps keep the FCM site, hosting, and domain name going.
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  If you can spare a $ or two then go here: https://www.patreon.com/fullcirclemagazine


  
    	For $1/month you get our eternal thanks, and a warm fuzzy feeling inside.


    	For $3/month you can have your name on the Patreon page in each issue of FCM.


    	For $5/month you can have access to a preview PDF of FCM two weeks before release day.

  


  If you’d rather use PayPal then that’s great. There’s a DONATE button in the right most column on the FCM homepage: http://fullcirclemagazine.org – just below the news on the right – and your name will appear on the Patreon page in each issue.

  


  Patrons and Donors


  PATRONS


  
    Bill Berninghausen Jack McMahon Linda P Remke Schuurmans Norman Phillips Tom Rausner Charles Battersby Tom Bell Oscar Rivera Alex Crabtree Ray Spain Richard Underwood Charles Anderson Ricardo Coalla Chris Giltnane William von Hagen Mark Shuttleworth Juan Ortiz Joe Gulizia Kevin Raulins Doug Bruce Pekka Niemi Rob Fitzgerald Brian M Murray Roy Milner Brian Bogdan Scott Mack Dennis Mack John Helmers JT Elizabeth K. Joseph Vincent Jobard
  


  DONATIONS


  
    John Niendorf Daniel Witzel Douglas Brown Donald Altman Patrick Scango Tony Wood Paul Miller Colin McCubbin Randy Brinson John Fromm Graham Driver Chris Burmajster Steven McKee Manuel Rey Garcia Alejandro Carmona Ligeon siniša vidović Glenn Heaton Louis W Adams Jr Raul Thomas Pascal Lemaitre PONG Wai Hing Denis Millar Elio Crivello Rene Hogan Kevin Potter Marcos Alvarez Costales Raymond Mccarthy Max Catterwell Frank Dinger Paul Weed
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  Contribute to Full Circle Magazine


  
    FULL CIRCLE NEEDS YOU!
  


  A magazine isn't a magazine without articles – and Full Circle is no exception. We need your opinions, desktops, stories, how-to’s, reviews, and anything else you want to tell your fellow *buntu users. Send your articles to: articles@fullcirclemagazine.org.


  
    FCM #109 Deadline: Sunday 08th May 2016. Release: Friday 27th May 2016.
  


  We are always looking out for new articles to include in Full Circle. For help and advice, please see the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471


  Send your comments or Linux experiences to: letters@fullcirclemagazine.org


  Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org


  Questions for Q&A should go to: questions@fullcirclemagazine.org


  Desktop screens should be emailed to: misc@fullcirclemagazine.org


  ... or you can visit our forum via: www.fullcirclemagazine.org



  Full Circle Team: Editor - Ronnie Tucker - ronnie@fullcirclemagazine.org


  Webmaster - Lucas Westermann - admin@fullcirclemagazine.org


  Podcast - Les Pounder & Co. - podcast@fullcirclemagazine.org


  Editing & Proofreading: Mike Kennedy

  Lucas Westermann

  Gord Campbell

  Robert Orsino

  Josh Hertel

  Bert Jerred



  Our thanks go out to Canonical, to the many translation teams around the world, and to Thorsten Wilms for the current Full Circle logo.


  Getting Full Circle Magazine:


  EPUB Format - Most editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with the epub file, you can drop an email to: mobile@fullcirclemagazine.org


  Google Currents - Install the Google Currents app on your Android/Apple devices, search for 'full circle' (within the app), and you'll be able to add issues 55+. Or, you can click the links on the FCM download pages.


  Ubuntu Software Centre - You can get FCM via the Ubuntu Software Centre: https://apps.ubuntu.com/cat/. Search for 'full circle', choose an issue, and click the download button.


  Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu Linux.>
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DearRonnie Tucker,

We are pleased to inform you that your order has been processed correctly and will be
dispatched from our warehouse today.

You will receive an email from our shipping agent enabling you to track your order.
If you have any doubts, you can contact us via email at contact@ba.com.

Please see below for a summary of the delivery information.
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